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Trademarks 
Unigraf, UCD, UCD-422, UCD-412, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

The Adopted Trademarks HDMI, High-Definition Multimedia Interface, the HDMI Logo and HDMI Port 

Logo are trademarks or registered trademarks of HDMI Licensing Administrator, Inc. in the United 

States and other countries. 

USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc. 

HDCP is a trademark of Digital Content Protection LLC. 

Altera and Intel FPGA are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or other 

countries. 

Windows® is trademark of Microsoft Corporation. 

macOS® is a trademark of Apple Inc. 

Linux® is a trademark of Linus Torvalds. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, under 

normal use and service, for twelve (12) months from the date of purchase from Unigraf or its 

authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or replacement 

of the product. Unigraf shall have the whole discretion whether to repair or replace, and replacement 

product may be new or reconditioned. Replacement product shall be of equivalent or better 

specifications, relative to the defective product, but need not to be identical. Any product or part 

repaired by Unigraf pursuant to this warranty shall have a warranty period of not less than 90 days, 

from the date of such repair, irrespective of any earlier expiration of original warranty period. When 

Unigraf provides replacement, then the defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-4XX Series products meet the essential health and safety requirements, is in conformity with 

and the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is a User Manual of UCD-422 Gen2, UCD-422 and UCD-412 test devices, that are USB-

connected video interface test units for use with a computer. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of the UCD-4XX units. 

• Provide instructions for the user on how to use UCD Console SW. 

Product and Software Version 
This manual explains features found in UCD Console SW Bundle 3.7. Please consult Unigraf for 

differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and FW 

versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is formatted 

as follows. Please read these notes carefully. 

Note: This text is an important note 

 

Warning: This is a warning about a direct risk for the functionality of the device 
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 INTRODUCTION 

Product Description UCD-422 Gen2, UCD-422 and 

UCD-412 

Product Features 

• UCD-422 Gen2, UCD-422: Reference Sink and Source for verifying HDMI connected devices. 

• UCD-412: Reference Source for verifying HDMI connected sinks. 

• HDMI 2.1 compatible. Supports FRL and TMDS signaling. 

• Supports HDMI video and audio up to 10K@30 Hz, 8K@60 Hz (YCbCr 4:2:0),  

4K@120 Hz (YCbCr 4:2:0) 

• Supports Display Stream Compression (DSC), and Enhanced Audio Return Channel (eARC) 

• Compatible with HDCP versions 1.4 and 2.3 

• 2 GB on-board high-speed video frame buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

UCD-422 units consist of a multimedia signal input stage with on-board frame buffer, an internal 

pattern generator, a control stage, and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format. The Interface and Control stages are either passing the 

captured data directly to the USB interface or storing it to the frame buffer. The internal pattern 

generator is able to source a signal for testing sink and branch units. The Interface & Control stages 

are receiving instructions from the host PC to configure and control the functionality of the unit. 

Please find below logical diagram of UCD-422 unit 

Delivery Content 

• Product shipment contains: 

• The UCD-422 Gen2, UCD-422 or UCD-412 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable for host PC connection 

• HDMI 2.1 grade HDMI cable 

• Micro-USB type B compatible cable needed for FW programming. 

• Ethernet cable needed for FW programming. 
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Connections 

The image below indicates the connections in UCD-422 unit and their description. 

Name Description 

HDMI in HDMI 2.1 compliant input from the upstream Source 

HDMI out HDMI 2.1 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

Programmer USB interface used in device FW update (behind a cover) 

Ethernet Ethernet interface used in device FW update (behind a cover) 

 

Note: Capturing and sourcing high resolution video modes, especially 4K 8K and 10K video modes and the 

120 Hz frame rate set stringent requirements on the video cables and connectors.  

 

Warning: In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 
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Safety and Operational Precautions 
Please find below the Safety Precautions for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings within the text of this manual.  

These Precautions and Warnings are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions and 

Warnings. 

• Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and cabling 

to the Power Adapter are intact. In case there are any doubts about the condition of the Adapter 

or cabling, stop using it immediately. 

• It is important to ensure that the used AC input voltage is within the specified range (100 to 240 

Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not connect 

the device. 

• UCD devices are rated for indoor use only. They are rated for Pollution Degree 2 as defined in 

IEC 61010-1. This classification corresponds to usage in a typical office or home 

environment. Under normal use, only dry, non-conductive pollution occurs. Occasionally, 

temporary conductivity caused by condensation can be expected. Temporary condensation 

occurs only when the product is out of service. 

• When installing the unit, connect the Power Adapter to the UCD device first, after that connect 

the AC plug. Please disconnect the USB cable to the controlling PC and remove cabling to DUT 

while connecting the power input cables. 

• It is forbidden to open the housing of the UCD device without written permission from Unigraf. 

Failure to comply with this rule will void the warranty of the unit. 

• UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes is 

forbidden. 

• Use UCD equipment only in its specified ambient temperature and humidity.  

• In order to ensure that the UCD device and associated SW will operate properly, please ensure 

that the PC used for controlling the UCD device complies with the minimum requirement set by 

Unigraf. 

• Please keep UCD software updated by regularly checking the updates on Unigraf download page 

(https://www.unigraf.fi/downloads/). Please update the device firmware to match the installed 

software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/. Please, note that there are separate packages for Windows, 

macOS and Linux 

The installation package is a bundle between the components needed for UCD Console SW and fo 

TSI SDK. The bundle contains the following items: 

Drivers (installed during set up)  

UCD Console SW (installed during set up) 

License Manager (installed during set up) 

Device configuration utility (installed during set up) 

Packet Editor (installed during set up) 

TSI SDK 

User Manuals including this document.  

In some cases, also the firmware of the unit needs to be updated. If in doubt, please contact Unigraf. 

Note: The software should be installed before connecting the UCD unit to the computer. 

 

Note: System administrator's privileges are required for performing installations. 

Software Installation 

Windows 

Install *.exe file from the package.  

Start installation by running application SoftwareBundle_X.X.XXXX. 

The welcome page is displayed and shows the software package release version. 

The user is also asked if he/she wants to: 

Create a desktop shortcut 

Install the Visual C++ redistributable (needs to be present on Windows) 

Install Unigraf USB drivers 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

 

macOS 

Install *.pkg file from the package. This is a universal binary for ARM and Intel x86. 

Start installation by running application SoftwareBundle_X.X.XXXX. 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

Note: If you are downgrading, please remove the Unigraf UCD Tools folder from the Applications 

folder before starting installation. 

Note: If installation fails, remove the Unigraf UCD Tools folder and any possible copies from the 

Applications directory and try again. 

 

https://www.unigraf.fi/downloads/
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Linux 

Linux extract the *.tar.gz file. You will find two install scripts (install-libfuse.sh and install.sh). 

In the Files app select each script in turn, right click and select Properties to open the 

Properties dialog. Toggle the Executable as Program button. 

In the Files app open a terminal window by unselecting any selected files and right clicking and 

selecting  Open in Terminal to run the scripts (order is important). 

In the terminal type:  sudo ./install-libfuse.sh 

You will be prompted for you password.   

Type: sudo ./install.sh  

You will be prompted with: 

Please proceed to 'Software & updates' application to tab 'Other Software' and uncheck 

checkboxes or remove 'cdrom' entry from /etc/apt/sources.list file. Otherwise you will have 

problems during UCD Console package installation. If you are already done, enter the key 'y'. If 

not - 'n' 

For Ubuntu just enter y. For debian follow instruction. 

You will then be prompted again with: 

Please proceed to 'Software & updates' application to the first tab and set check box 'Officially 

supported (main)'. Otherwise you will have problems during UCD Console package installation. 

If you are already done, enter the key 'y'. If not - 'n' 

For Ubuntu just enter y. For debian follow instruction 

Answer y for additional prompts. 

The Ucd Tool Installer Setup app should now be running. 

Select Next> 

Select radio button for Install for all users or Install just for me. 

You are asked to Choose Installation Directory. Do NOT choose the default 

(/root/Unigraf/Unigraf UCD Tools at time of writing). Select a directory that is easy to access 

and remember. 

Note the warning: Installing in existing directory. It will be wiped on uninstallation. 

Select Next> Install and Finnish. 

Navigate to the Unigraf UCD Tools directory under the installation directory and double click 

the app you want to run (UCDConsole.AppImage for example). 
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Firmware Update Procedures 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible operation roles present in the UCD unit. A firmware 

set for the selected operation roles is created and the firmware set is programmed to the device. 

Please contact Unigraf for details. 

Updating from Earlier FW Versions 

UCD Firmware versions prior to 1.8.52 (see Help > About on Consol) do not support the procedure 

described here. Follow the instructions in Appendix G Firmware Recovery Procedure with Quartus 

Prime in this manual. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do not 

power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-4XX device, perform the following 

steps: 

 Connect the UCD unit to a power supply and connect the USB cable. 

 Open UCD Console SW. Select Tools > Firmware Update. UCD Config will open. 

UCD Config 

The first page of the utility indicates the firmware component versions present in the package. Select 

Enable advanced mode checkbox if you want to customize the installation (possibly to downgrade 

firmware for example). Enable patching (Internet connection is required) check box is not relevant 

for UCD-4XX devices. 

Select Next to proceed. 
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UCD Device Selection 

From the list of connected UCD devices please select the one that you want to update. Click Next. 

 

Review updates 

A new dialog lists: 

 FW components available in the UCD device 

 Current FW version (from) 

 FW to be installed (to) 

 

Note: Selecting individual components for update is only enabled in Advanced Mode. 

Click Start to start the FW update procedure. 

 

 

. 
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Advanced Mode 

Advanced mode allows users to select individual components to update. Click Next to review the 

components and start the update procedure. 

 

Configuration in progress 
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During the installation, you will be prompted to power cycle the device (power off, wait for 10 seconds 

and then power the device on again). Select OK to proceed. 

 

After the update has finished, click Next to see a summary and select Finish to complete. 

Please note that the update proceedure may take several minutes to complete. 

Recovering Failures in FW Update Procedure 

If FW Update procedure fails (e.g., when updating from an earlier FW that does not support the 

procedure described here) refer to Appendix G of this manual for instructions in Firmware Recovery 

Procedure with Quartus Prime.  

Once FW Recovery procedure has been done and a Firmware version supporting UCD Firmware 

Configuration tool has been installed, all future updates can be done using this tool. 
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Firmware Downgrading 
The previously released Unigraf SW Bundle 2.4.XX package does not contain UCD Device Firmware 

(FW). In case UCD device has been installed with the FW delivered with Unigraf 3.X SW Bundle, and 

version downgrade is needed, also UCD Device Firmware has to be rolled back.  

Please follow the procedure below: 

1. Download the latest Console 2 SW Bundle (2.4.XX) from Unigraf download page at 

unigraf.fi/downloads. 

2. Run the application SoftwareBundle_2.4.XX.exe in the package to install the package. Please 

do not launch UCD Console application yet. 

3. Download Console 2: FW Package 2.3.38 from the same download page 

4. Run the application FirmwarePackage_2.3.38.exe to copy UCD device FW in a proper folder 

in your PC 

5. Launch UCD Console 

6. Select Tools > Firmware Update to start UCD Config utility 

7. In UCD Config select Enable advanced mode 

8. Select the device. Click Next. 

9. In UCD Modules select the module titled MFMN4XX F.X.X.X/N.X.X.X 

10. Click Next. Click Start to start programming FW to the connected UCD Device 
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License Manager 

Licensing 

The features of UCD Console SW are divided into groups based on the target use of the device. Most 

basic features can be used by default, and more advanced feature groups are enabled by dedicated 

licenses. When the licenses are present, the related part of the GUI will be shown, or the related 

control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables a 

dedicated function in one device. Each device has its dedicated Seed Number. Each License Key is 

tied to one Seed Number. License Keys can be freely used in any number of PCs 

License keys are managed with UCD License Manager. The License Manager can be found in the 

Tools menu of UCD Console SW. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices please 

Select the device in question. The serial number and the seed number of your device are printed in 

a sticker attached to the bottom of the device.  

The Rescan… button will re-scan the system for installed hardware. 

Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the field 

for new licenses. The License Manager will automatically move the caret across the edit boxes during 

typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click Install. The license is authenticated and if it is valid, the 

license will appear in the list of installed licenses. If the key fails to authenticate, an error message is 

displayed. If this happens, please make sure that the key has been typed correctly and that the seed 

number on the license key sticker matches the seed number displayed in UCD License Manager. 

Click the Search inverted triangle at the upper right to view the Find edit control. Enter a search 

keyword: The license list is updated to show names that contain the keyword.   
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Note that to avoid confusion, some letters will never appear in a license key because they resemble 

numbers: For example, capital 'G' and number '6' are very similar when printed with small font. When 

in doubt, use numbers. 

Also, please note, that characters that cannot be part of valid license key are not accepted as input. 

When appropriate, an automatic conversion is applied while typing: For example, lower case letters 

are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all installed licenses for the selected device. The list shows the name 

of the license and the actual license key characters. 

Import: Install licenses from an INI file for the currently selected device. 

Export: Save installed licenses for the currently selected device into an INI file for 

backup and distribution to other PCs.  

To export license(s), select the license(s) to be exported and then click the 

Export button. Please note that licenses from multiple devices can be 

exported into the same INI file. 

Remove Selected: Uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button 
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UCD Console 
UCD Console SW is graphical user interface (GUI) for UCD family test equipment for desktop use. 

UCD Console provides the user access to all features of the unit. UCD Console also includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display interfaces and 

assist in problem detection.  

The various features of the UCD unit are divided into interface specific screens and tabs. Each tab 

contains data and controls for a specific feature.  

Device Selection 

A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console is launched, the dialog provides a list of Unigraf UCD devices connected in the 

PC. Please select the target device by double clicking on the appropriate row. If your device cannot 

be found in the list, please confirm the power and USB connection to the device and click the Rescan 

… button. 

Analyzer and Generator Operation 

Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator (a 

Source device). The functionalities of the two operation modes can be found in separate tabs. This 

User Manual will explain both roles and all role functionalities. 
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Options 
Options can be found in Tools > Options. 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM format 

the files are stored with the captured color depth, with other formats the color depth is truncated to 8 

bits per color. 

Audio File Format 

Audio files are stored in WAV format. 

Displays HDCP Compliance 

Information if controlling PC is HDCP compliant, i.e. if preview of HDCP encrypted content can be 

enabled. If the display is non-HDCP compliant or when connected to the PC using RDP (Remote 

Desktop Protocol) then users will be presented with a blue background with a banner stating ‘H  P 

unauthorized’. H  P is currently only supported on Windows OS and not supported on MacOS and 

Linux. 

Folders 

Please select the directories in the PC for saving the captured images and audio. 

DSC 

DSC temp folder: Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related configuration files and 

DSC conversion tools are stored. 

Keep auto-created DSC 

content files: 

By default, the DSC compressed content is deleted after use. If 

selected, the content is not deleted. 

Warning Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large (appr. 400 GBytes). 

Please make sure that the content will be stored in a medium that has the required space available. 

 

DUT Testing Options 

Configure DUT Testing reports. 

Include time info in Report logs: Include system date and time in the beginning of each 

event line in created reports. 

Do not show again test sequence 

completed: 

Include system date and time in the beginning of each 

event line in created reports. 
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Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and controlling 

separate features simultaneously. To detach a tab Right-click on a tab and select Detach Window. 

To glue the tab back to the main window, click on the red Close button in the top right-hand corner 

of the window or press <Alt> + F4 on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

simultaneously without swapping addresses. To clone a tab Right-click on a tab and select Clone 

Tab or Clone and Detach to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, the UCD device acts as HDMI Sink or Receiver device. 

Analyzer functionality related controls and dialogs can be used by selecting HDMI RX tabs.  

Please note that in most UCD-4XX Series units, Generator functionality is available simultaneously 

with Analyzer. Please find the description of Generator functionality later in this manual.  

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Functionality Tabs 

Analyzer role features the following tabs: 

• Video preview and saving (Video) 

• Audio monitoring and saving (Audio) 

• EDID editor (EDID) 

• HDCP status monitor and control (HDCP) 

• Source DUT Testing tab 

• Event Log 

• Status information and control of the upstream link (Link) 

• Received InfoFrame packets (InfoFrame). 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing. 
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Link Tab 
Link tab contains the following: Behavior, Status, TMDS Status, FRL Capabilities, FRL Status, Audio 

Return Channel, HDCP Status and Configuration, Video Status and HPD. 

Behavior 

Selection of HDMI operation mode: HDMI 1.4, HDMI 2.0 or HDMI 2.1.  

Please perform HPD Deassert - Assert after change of mode. 

Status 

Channel lock: Status of Channel Lock in the four lanes and currently selected HDMI 

mode 

Error count: Contents of the SCDC Error counter registers of the UCD-422 Sink. 

Auto Adjustment Adjustment errors on lanes. 

Behavior: Assigned HDMI mode 
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TMDS Status (Only in TMDS Mode) 

Mode: Indication of HDMI / DVI mode 

TMDS Bit Clock Ratio: TMDS Bit Period / TMDS Clock Period ratio (1/10 or 1/40)  

Input Stream Lock: Indication of TMDS character lock 

FRL Capabilities (Only in FRL Mode) 

FRL Capabilities allows the user to change the way the Sink capabilities are announced in the SCDC 

capability registers of the UCD-422 Sink. 

Disable FRL: Disable FRL mode 

Capability Radio 

Buttons: 

Selection of the maximum link count and link rate capability of UCD-422 

sink. Written to FLR_Rate configuration register of UCD_422 Sink.  

Please click Re-train to apply  

FRL Start:             h        i k’   RL_       i  (1/ ) 

FLT Ready:             h        i k’   LT_    y  i  (1/ )  

FLT No Timeout:     u      h        i k’   LT_  _ i   u   i  (1/ ) 

FRL Max:     u      h        i k’   RL_  x  i  (1/ ) 

Check Patterns:     h  k          i  u           h    h   ’     p       v  i i   i    u i g 

link training 

LTP Add: Additional R qu      Li k T  i i g p       i        i k’  L X_LT _  q 

(X=0-3) register. 

Re-Train: Request a new link training  

Apply: Store new settings 
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FRL Status (Only in FRL Mode) 

FRL Status displays the status of the link training and the link parameters negotiated between UCD-

422 Sink and the Upstream Source. The status is updated automatically. 

FRL Data 0/1/2/3: Indication of data flow in FRL links 0 to 3  

FFE Level: Status of Feed Forward Equalizer Level that HDMI transmitter is using 

(only in FRL mode) 

LTP Request: Currently requested FRL link training pattern.  

FRL Mode: Lane count and link rate configuration used in FRL mode 

LT Status: Status of the FRL Link Training State 

FLT Update: Status of the UCD-422  i k’   LT_up      i  (1/ ) (   y i   RL     ) 

FLT No Retrain: Status of UCD-422  i k’   LT_  _     i   i  (1/ ) (   y i   RL     ) 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration 

Enable and disable HDCP 1.4 or HDCP 2.3 capability of UCD-422 Sink. Duplicates of the controls 

found in HDCP tab. 

Video Status 

Video Timing and Color Details as retrieved from stream metadata. Frame rate is measured by UCD-

422 Local Sink.  

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components 

calculated by the Sink hardware. To re-calculate, click Update. Click Copy to store the information 

to the clipboard. 
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HPD 

High: LE  i  i       h    h       ig    i  A        (  gi    “high”)  

Deassert: Click  u                 i        gi    “  w” (  -asserted) and hence no HPD 

pulse can be generated.  

Assert: Click to re-   iv     h       i   (         gi    “high”)  

Audio Return Channel 

Enable: Enable eARC 

Source: Select source 

Mode: Single or Common 

 

 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Status 

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 
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Declared as HDCP 

capable: 

The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

SST Mode Type Type when in SST mode (DP). 

Configuration 

HDCP Capable:  To inform source DUTs that TE (UCD device) is HPCD capable or not. 

Uncheck to disable. 
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HDCP 1.x and HDCP 2.x Repeater Emulation 

  

For HDMI the UCD device can simulate a HDCP repeater. Check the Repeater Simulation box to 

enable the rest of the controls. 

Depth: Depth of Repeater (maximum 4). 

Device count: The number of devices that act as repeaters (maximum 32). 

KSV Value KSV value assigned to each device. 

Receiver IDs Receiver IDs 

Status Shows HDCP authentication of repeater. 

 

The Device count can be change via the spinbox or the +/- buttons. 

Inverted triangles are used to navigate the KSV rows. 

Use the Preset dropdown to Save, Load and Remove named (saved internally) sets. 

Use the Import and Export options to load and save to files. 

Press Apply to apply settings. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  
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Capture Tab 
UCD device has an internal frame buffer that can be used for continuous capture of video data. In 

addition, audio and metadata can be captured and saved for later analysis. 

HDMI Events see HDMI Link Analyser Tab Events. 

 

Start / Stop Start or stop capturing. Button label changes per action. 

Capture N frames: The number of video frames to capture. 

Format: Selection of the format of the saved video frame bitmaps. BIN, PPM, 

BMP, BIN + PPM, BIN + BMP. 

Buffer  capacity: The number of video frames that can be stored to UCD frame buffer 

using current video signal format. 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB).  

Create scenarios Define the length of the scenario. 

Events: Please refer to chapter Event Log for details of the captured events. 

Audio: Enable audio. 

Status: Status of the capture. 

Open Timeline Viewer Open Event Timeline Viewer to view the captured data. For detailed 

instructions refer to chapter seven of this manual. 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

 u        i  “ u      _  p u  _yyyy    _hh    ” (  g , 

buffered_capture_20210301_130532). 
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Video Tab 
Video tab is the Preview window for the captured video stream. 

Disable / Enable Preview 

Click the button to start or stop capturing video frames. 

Video Status 

The details of the captured video are presented below the preview window. 

First row: Cursor location, pixel value at cursor location in YCbCr and RGB  

Second row: Time stamp, Color mode, color depth, frame counter. 

Third row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Fourth row: Live preview frame rate. 

Note: HDCP preview is only available on UCD Console for Windows operating system. 

 Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. The rate is limited e.g by the USB communication between UCD test equipment and the PC. 
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Override Color Detection 

The captured video will be by default automatically converted to RGB 8 bpc for preview and saving 

based on the information in video metadata.  

By clicking Auto button, a dialog opens for overriding the automatic conversion. Captured image data 

will be interpreted based on the values set in the dialog.  

Color space: Define as which format captured data will be interpreted. 

(Auto-detect, RGB, YCbCr4:4:4, YCbCr4:2:2, YCbCr4:2:0) 

Colorimetry: Define as which colorimetry captured data will be interpreted. 

(ITU-R BT.601, ITU-R BT.709, ITU-R BT.2020) 

Bits per color Define as which color depth captured data will be interpreted. 

(Auto-detect, 6, 8, 10, 12, 16) 

Note: Please note that the color mode selection applies to the preview window only. All internal functions 

use the raw image data as captured from the input channel. 

Frame recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode can 

also be enabled in this dialog. 

Buffered When checked, all input frames are captured non-drop until the on-board frame 

buffer will be full. 

When not checked, only one input frame is buffered at a time. Frames will be 

skipped if the transfer of the data to the PC is slower than the input data rate. 

Capacity of the buffer Capacity of the on board frame buffer with the selected video and color mode. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 

Recorded frames are stored by default in C:/Users/<Current user>/Pictures. Please refer to Tools > 

Options where the location of this folder can be customized. 

Open 

 

Open folder where captured frames are stored. Double click or click Open to select a frame file for 

viewing. Please refer to Tools > Options where the location of this folder can be customized. 
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Full Screen 

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen to exit full screen mode. 

Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of the 

preview image.  

Info field in the lower right side of the bottom panel lists: 

• Location of the cross cursor on the bitmap stating from the upper left corner 

• The intensity of the Red, Green and Blue components of the pixel on the cursor location in 

decimal values 

• The HTML HEX color code of the pixel on cursor location 

• In case of YCbCr color mode the intensity of the Y, Cb and Cr components of the pixel on the 

cursor location in decimal values 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25%, 50%, 100%, 200%, and 500% 
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Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of the 

preview image and selecting Save as…. The format and storage location can be selected in the 

opening dialog. The available bitmap formats are BMP, JPG, PNG and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from the 

display interface or if the color mode conversion selected for preview will be applied. 

Previewing DSC Decompressed Stream  

In order to capture and preview DSC compressed video DSC must be enabled in Link Capabilities 

dialog in Link tab. 

Select Enable Preview to verify that DSC compressed stream is received. 

Click Snap button to capture one frame and start the decompressor (offline in the PC). Once the 

decompression is ready, the frame is shown, and Log lists the details of the compressed image. A 

snapped DSC image can be saved as a DSC-file. 
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HDMI Link Analyzer Tab 
Capture Data Events for analysis with Link Timeline Viewer. See chapter Link Timeline Viewer for 

details. 

Link Analyzer buttons 

Start Start capturing main link data using Main Link Capture Options.  

Open Timeline 

Viewer 

Open Link Timeline Viewer. See Timeline Viewer. 

Open storage folder Open folder in the PC where capture data is stored. Folder is the video 

storage folder defined in Tools > Options.  

Captured video, audio and data is saved in a subfolder of this folder. The 

         h   u        i  “capture_yyyymmdd_hhmmss). (e.g. 

capture_20210215_093351). 

 

Main Link Capture Options 

Amount: The amount of data logged to buffer. Buffer size 2 GBytes maximum. 

Trigger Point Options 

Data capture start can occur with or without defined trigger criteria. 

Trigger criteria dropdown has four options: No active trigger, HDP assert, HDP deassert, I2C 

transaction, CEC transaction, Main Link video lock and Packet data. 
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When I2C transaction is selected, a drop down list box is enabled and visible with options: Write, Read 

and Any. Two spinboxs are enabled for I2C Device Address and I2C Register Address. 

 

When CEC transaction trigger is selected, available trigger options are shown below. 

Select trigger options via checkboxes OVERDATA_ERROR, START_TIMING_ERROR and/or by filling 

in the CEC Template Data (hex) values. 

 

When the Main Link video lock trigger is selected, available checkboxes are GXB_LOCK_RISE, 

VID_LOCK_RISE, VID_LOCK_FALL,  HDCP1_AUTH_RISE,  HDCP1_AUTH_FALL,  

HDCP1_ENC_EN_RISE, HDCP1_ENC_EN_FALL, HDCP2_AUTH_RISE,  HDCP2_AUTH_FALL,  

HDCP2_ENC_EN_RISE, HDCP2_ENC_EN_FALL, TMDS_CLK_LOCK_RISE, EXT_PIN_RISE, 

EXT_PIN_FALL. 
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When Packet data is selected: Checkbox BCH_ERROR, when checked, will start capture when a 

BCH_ERROR error occures (and only when one has occurred). Fill out packet Template Data (hex) to 

filter events to start capture. Shown below is a trigger for AVI Infoframes in general. 

 

Position 

Triggered capture timepoints available are: Start, 25%, 50%, 75%, End.  

Events 

The following events can be selected via checkboxes: 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal 

Packets 

HDMI infoframes. Click the button to open the Event Filter Dialog. 

Packet events without checkboxes can be added via the Enter packet type edit control (0x2 for audio 

sample for example). 

 

I2C 

Capture I2C communication. Click the button to open the Event Filter Dialog. 
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Use edit control Enter packet type as hex separated by comma: to add packets manually. 

 

CEC 

Capture CEC communication. 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and recording. 

Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways. 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display 

can be selected between ‘Linear’ to 100 dB. 

• The span of the oscilloscope preview window is defined with Playback buffer found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Playback buffer depends on the 

sampling frequency. Please do not exceed the Main buffer set in the same dialog. Please refer 

to description of the Video Audio and Misc Options earlier in this document. 

Enable Preview / Disable Preview 

This button controls capturing the audio data. 

Select Monitored Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current Stream 

selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

‘oscilloscope’ panel will seem static. Signal capture can be verified by ensuring that Frame # below 

the panels is increasing. 
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Playback device selection 

The captured audio can be played back in the PC. The combo-box defines the audio device in the 

host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD-4XX EDID. Since UCD-4XX is not performing 

any audio format conversion, it might occur that the source provides an audio format that the selected 

playback device does not support. In case a conflict occurs, please change manually the EDID 

content or disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Audio Buffer Size 

The amount of buffering used in the data transfer between the UCD-4XX unit and the PC in Audio 

buffer size in Tools > Options dialog, Main buffer. Increased buffer size will ensure a smooth audio 

output but will also increase the delay between the capture of the audio stream and its playback. 

Start audio recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream and the 

number of audio packets captured. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID data of the UCD Sink presented to the connected 

Source Device. There are three basic functions: 

• Load and save data files on the host PC. 

• Edit contents in Editor Mode or the Hex Edit Mode. 

• Read and write to EDID memory for up to 4 virtual ports. 

EDID 

 

With Load… and Save As… a file can be read or written to from a PC. Please note that the program 

does not alter the contents of the file or verify its integrity during load and save operations. 

Note: Four blocks (512 bytes) are read. If the device does not support all four blocks, the non-supported 

data is replaced with zeros. 

Text EDID 

The Text EDID tabs allow viewing data in tree form. 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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Source DUT Testing Tab 
Please refer to Appendix E for descriptions of the tests available. The tests are presented in a split 

view, the right being test categories and the left being the tests in them. 

 

Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category when 

running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 

On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open  a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 
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Test Parameters 

Each test suite has a dedicated set of test parameters. Select Configure to launch the parameters 

dialog for the selected tests. 

See Appendix E for parameter descritptions for each test category. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

• Save parameters in Configure dialog as Presets to be later used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that Importing and Exporting *.json files here have a different format than importing 

those described above. 
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InfoFrame Tab 
InfoFrame Tab displays received InfoFrames. Click Refresh to update the list. Show / hide the parsed 

data by selecting Packet Info.  

Received InfoFrames 

InfoFrames tab displays in hexadecimal format the following received InfoFrames: 

• ACR (Audio Clock Regeneration) 

• ASP (Audio Sample Packet) 

• GCP (General Control Packet) 

• ACP (Audio Content Protection Packet) 

• ISRC1 (International Standard Recording Code) 

• ISRC2 (International Standard Recording Code) 

• OBA (One Bit Audio sample packet) 

• DTS (DTS Audio packet) 

• HBR (High Bitrate Audio stream packet) 

• GMP (Gamut Metadata packet) 

• EMP (Extended Metadata Packet) 

• 3D ASP (3D Audio Sample packet) 

• 3D OBA (3D One Bit Audio sample packet) 

• AMP (Audio Metadata Packet) 

• MST_ASP (Multi-stream audio sample packet) 

• MST_OBA (One Bit Multi-stream audio sample packet) 

• VSI (Vendor Specific InfoFrame) 

• AVI (Auxiliary Video Information) 

• SPD (Source Product Descriptor) 

• AIF (Audio InfoFrame) 

• MPEG (MPEG Source InfoFrame) 

• DRM (Dynamic Range and Mastering InfoFrame) 

Saving InfoFrames 

Infoframe packets can be saved in a file in binary format. Click Save and in the dialog select the 

packet types of choise. File name will be of format EMP_2022-07-28T15_54_24.bin, where EMP is 

the packet type and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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Infoframe Features 

Observe features found in infoframes by selecting Features.  
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CEC Tab 
The CEC Tab is used for sending and receiving CEC (Consumer Electronics Control) protocol 

messages and data. The CEC Tab is grouped into two panels: CEC Info and CEC Controls. 
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CEC Info 

CEC data and received status can be seen in the CEC info panel. 

 

 

Version: CEC version number 

Operation number: CEC operation number 

Buffer status: Shows buffer status 

CEC response: Enable CEC response. 

CEC data: Shows CEC data received 

Reset All: Remove all rows 

Reset: Remove selected rows 

Refresh: Check for new data 
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CEC Controls 

 

Use CEC Controls to send data a HDMI follower via CEC protocol.  

 

Select all: Select all added items 

Send: Transmit via HDMI CEC protocol 

Add: Add an Operation code with 

parameters to be sent to various 

devices 

Remove: Remove selected items. 

Presets: Save, load, remove, import and 

export presets 
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Add 

 

 

 

Logical address: Initiator address 

Destination: Destination device 

Physical address: Physical address of device. Auto-filled 

by firmware 

Operation code: Opcode 

OP code param size: The size of operand(s). Minimum is 

0x0, maximum is 0xE. 

OP code parameter (as hex value separated by comma) Operand(s) 

Device type Select device type 

  

 

Note: Event Log can also monitor the received CEC frames 
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Remote 

The interface simulates the function of a remote control. 

 

 
Power Toggle  

 
Up 

 
Power on 

 
Down 

 
Power off 

 
Left 

  
Root menu 

 
RIght 

  

Exit 

 
Select 

   

Channel up 

Channel down 
 

Volume up 

Volume down 

 

CEC Flow 

 
Logical address (initiator)  

 
Logical address (destination) 

ADDR Physical address 

 



  Generator Operation 

UCD-4XX User Manual • UCD Console 3.9 50 

 GENERATOR OPERATION 
When used as a Generator, the UCD device acts as an HDMI Source or Transmitter device. Generator 

functionality related controls and dialogs can be used by selecting DP TX or HDMI TX tabs.  

Please note that in most UCD-4XX Series units Analyzer functionality is available simultaneously with 

Generator functionality. Please find description of Analyzer functionality earlier in this manual.  

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Functionality Tabs 

Analyzer role features the following tabs: 

• Link (Link status and configuration) 

• Video pattern generator (Pattern Generator). 

• Content Playback (Playback) 

• EDID editor (EDID) 

• HDCP status monitor and control (HDCP) 

• Sink DUT Testing 

• Adaptive-Sync 

• Status information and control of the downstream link (Link). 

• SCDC monitor (SCDC) 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing 
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Link Tab 
Link tab shows the status and control items for the HDMI link. 

  

HDMI Behavior 

Selection of the HDMI version to be used (HDMI 1.4 / HDMI 2.0 / HDMI 2.1). 

Status 

 

Channel lock: Status of Channel Lock in the four lanes.  

Error count: Contents of the SCDC Error counter registers of the connected Sink. 

Behavior: Assigned HDMI mode. 

Video Video signal status. 
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TMDS Status (only in TMDS mode) 

Mode: Status of the HDMI/TMDS mode (HDMI/DVI) 

TMDS Bit Clock Ratio: Status of TMDS_Bit_Clock_Ratio bit in SCDC – TMDS Configuration 

(1/10 or 1/40) 

Scrambling: Status of TMDS_Scrambler_Status bit in SCDC – TMDS Scrambler 

Status (1=LED on; 0=LED off) 

TMDS Control (only in TMDS mode) 

Mode: Selection of the HDMI/TMDS mode (HDMI/DVI) 

Link Mode: Selection of TMDS Bit Period / TMDS Clock Period ratio (1/10 or 

1/40) (3G / 6G) 

Enable Scrambler: Control of Scrambling_Enable bit 

FRL Control 

Disable FRL: Disable FRL mode 

Capability Radio Buttons: Selection of the link mode used for FRL link training.  

FFE Max: Set the maximum FFE level (0 to 4) supported for each FRL rate 

LT Timeout: The time used for FLT Timer (default = 200 ms) 

LT Poll Timeout: Poll interval for FLT_update flag (default = 2 ms) 

 

Please click Link Training to apply 
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FRL Status 

FRL Mode: FRL Mode used by UCD-4XX HDMI source 

LT Status: FRL link training status of UCD-4XX HDMI source 

FLT Update: Status of FLT_update flag in SCDC Update Flags register of the connected 

HDMI sink. 

FLT Ready:  Status of FLT_ready flag in SCDC Status Flags register of the connected 

HDMI sink. 

FRL Start: Status of FLT_start flag in SCDC Update Flags register of the connected 

HDMI sink. 

FLT No Timeout: Status of FLT_no_timeout flag in SCDC Source Test Configuration register 

of the connected HDMI sink. 

FRL Max: Status of FRL_Max flag in SCDC Source Test Configuration register of the 

connected HDMI sink. 

 

Lane Status Matrix 

LTP: Status of Lnx_LTP_req (x = 0 to 3) fields in SCDC Status Flags register of 

the connected HDMI sink 

Pattern: Link Training Pattern used (0 to 8) 

FFE Level: FFE level used (0 to 3) 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration 

Enable and disable HDCP 1.4 or HDCP 2.3 capability of UCD-422 and UCD-412 Sink. Duplicates of 

the controls found in HDCP tab. 

HPD (Bottom panel) 

The status LE  indicates the state of the HP  signal Asserted (logical “high”) or  e-asserted (logical 

“low”). 
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Pattern Generator Tab 

 

Force EDID preferred 

timing after LT 

UCD reads the EDID of the connected Sink and after next LT enables to 

Stream 0 the timing listed in 18-byte descriptor 1 in VESA block of the 

 i k’  E     

Use timings from EDID UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings Please see chapter Manage Timings later in this manual. 

Total bitrate: Used link payload / Total link capability in Gbps (Pls see Note below). 

Auto-Apply To avoid sourcing invalid video mode combinations new settings are 

being validated when the user is clicking Apply. 

Automatic validation will be applied when Auto-Apply is checked. 

Apply Apply recent changes. 

 

Pattern Generator Status panel shows the Timing, Pattern (Name), CEF (color format and 

subsampling and colorimetry), BPC (bits per color), Status, and CRC value, for each active stream. 

Note: A full description of Minimum link configuration combinations for UCD standard video modes is 

available. Please contact Unigraf for details. 
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Pattern 

Configuration of the video sent in the corresponding stream  

(Controls vary between selected pattern type) 

Predefined Timings 

The list includes a set of common fixed video timings. Please find a list of the timings with their major 

details in Appendix C of this document. With Manage Timings function the user can add timings in 

the list and select which timings are shown in the selection. 

Color Depth 

Available color depths are: 6, 8, 10, 12 and 16 bpc. Color depth 6 bpc is only available when using 

RGB color format in DisplayPort or DisplayPort Alt Mode. 

Video Pattern 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled you can have the links activated but no video data transferred. 

Note: When MST mode is selected, full selection of test patterns is available only in stream 0  

Filter 

Filter timings by specific vendors and resolutions. Timings can be sorted by Vendor ID or width. 

HDMI timings are sorted by VIC number by default. 

 

Custom Image Patterns 

BMP, PNG, and JPG files can be loaded from the PC to be used as custom images. 

Please refer to Link Pattern in description of DP and DP Alt Mode Reference Source Link tab later in 

this manual for sending special DisplayPort binary patterns in the link instead of video.  

Color Depth 

Predefined  

Timings 

Selected 

Pattern 

Color Format and Subsampling 

Pattern 

Option

s 
Colorimetry 

Load pattern file Loaded 

pattern file 

Bitmap scaling 

Quantization 

Range 

Filter 
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Bitmap Scaling 

When bitmap patterns are used, they can be used either in their original resolution, aligned to left top 

corner (=un-check Scale), or upscaled or downscaled to match the selected video resolution (=check 

Scale). 

Pattern Options 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 
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Pattern Scrolling 

When Pattern Scrolling is enabled, the pattern is moved horizontally and vertically between display 

scans. The function is available for all patterns except the following: Color Bars, Chessboard, Solid 

Color, Solid colors (white, red, green, blue), White V-Strips, Motion Pattern, DSC Pattern. 

Enable: Enable or disable pattern scrolling 

Horizontally X pixels: Horizontal step of the pattern movement in pixels  

(values in range -127… …128,     Y     4:2:2  v   v  u  )   

0 = no movement, positive values = pattern moves to the right. 

Vertically Y pixels: Vertical step of the pattern movement in pixels  

(even values in range –127… …128,     Y     4:2:   v   v  u  )   

0 = no movement, positive values = pattern moves up. 

Every N frame:     y    p         v      i   i p  y        (v  u   i     g   … 255)   

0 = no movement, 1 = move every frame, n = move every n:th frame. 

Note: Please click Apply to enable changes or check Auto-Apply. 
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Sourcing DSC Compressed Patterns 

UCD Pattern Generator function can source DSC content originating from pre-created DSC 

compressed files. DSC compressed pattern files can be created with a separate tool called DSC 

Compressor. It can be launched from Tools > DSC Compressor. 

 

Select the source bitmap file in Source File field. Define the Output Resolution, the color depth, 

compression ratio and number of horizontal and vertical slices in the frame. 

Source File: Source bitmap file to be compressed (JPG, PNG, PPM) 

Sink DSC capability registers: Click Update to read DPCD registers 0x60 to 0x6f from the connected 

Sink device 

Color Space: Color space of the output compressed file (RGB, YCbCr 4:4:4, 4:2:2, 

4:2:0, Simple 4:2:2) 

Color depth: Color space of the output compressed file (8, 10, 12, 16) 

Output resolution: Resolution of the output compressed file 

Resize mode: The way the DSC image is created from the Source file 

Compression ratio: Used compression ratio 

Horizontal slices: Nr. of slices horizontally (1 to 24 Slices) 

Vertical slices: Vertical slices (1 to 24 Slices, Custom)  

Custom vertical slices size: minimum 1, recommended 108 

YUV Color range: Selection of color range between Full range (Full) (0 to 255 at 8 bpc) 

and Limited Range (CTA) (16 to 235 at 8 bpc) 

Refresh: Refresh the list after adding a custom resolution 

Custom: Create a custom output resolution  

DSC Version: DSC version used (1.1, 1.2) 

Line Buffer Depth: Line buffer bit depth used to generate the bitstream. (8 to 16 bits, 

default 9 bits) 

Open storage folder: Open DSC temp folder defined in Tools > Options 

Start Compression: Start the compression process 
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Result of the compression process is saved in the same folder as the source file. The start of the file 

name is the same as the source bitmap file; resolution and color format are added to the end of the 

file name. 

Example:  

unigraf_default_image_16k.ppm >> 

unigraf_default_image_16k_1920x1080_YUV422_FULL_bpc8_bpp6.dsc 

To use the created DSC file in Pattern Generator, select pattern: Select DSC Image and click Select 

… to open file selection dialog. 

When a DSC image is selected as the pattern, UCD Console will automatically enable DSC, provided 

that the connected Sink device declares support for DSC in its DPCD. 

When Select DSC Image pattern is being transmitted and incompatible Horizontal and Vertical Active 

timings are set (Via Apply or Apply All), the user is presented with a dialog: H-Active and V-Active 

don’t match with DSC data. Do you want to upload image? 

 

 

 

 

 

Above, “Do you want to upload image?” is misleading and will be changed to “Continue to transmit 

image?”. 

If you select No, the new settings will not be applied. 

If you select Yes, the Pattern will continue to be transmitted. DSC data is transferred in the active 

window. To transfer all DSC data without loss, active video should be large enough for DSC 

compressed data (DSC_pic_height * DSC_pic_lenght / compression_ratio). MSA H-active should also 

not be less than DSC pic_height. 

MSA V-active parameters can be reduced without DSC corruption until active video area is no longer 

large enough to pass all DSC data. 

MSA V-active and H-active can be increased until HW limitation (pixel clock limit) and link bandwidth 

are reached. 
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Preview DSC image 

 

To preview an DSC image before it is applied to the pattern generator, select the eye icon. CRC and 

DSC CRC values will be indicated in the preview image. 
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Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can be 

limited by un-checking the checkbox in the left edge of Name column. The timings will remain in the 

list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon  indicates that a timing is a 

fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon . 

New: Create a new custom timing based on the selected fixed timing. 

Delete: Delete the selected custom timing 

Save: Save changes in the selected custom timing. 

Revert: Undo all changes 

The dialog parameters will be sanity checked and will warnings issued for illegal combinations. 

HDMI Timing Generator  

 

HDMI Timings can be generated and applied via the Timing Generator group. 
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To do this select CTA or OVT timings radio button. Select desire RID and FR or VIC in combo boxes 

and then click the Generate button. 

The generated values will be reflected in the Frame parameters. Click Apply to set timing.  
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Playback Tab 
 

Playback allows for running predefined Playlist files. Playlist contains a set of Scenarios with definitions 

of the timing, video pattern, audio content and related metadata packets and their duration. 

 

Term Functionality 

Playlist 

Playlists (text files) specify the UCD devices 

and output protocol for transmission. It lists 

scenarios to be transmitted. 

Scenario 

Scenarios (text files) allow users to select 

video frames, metadata packets and audio 

to be transmitted and their order. 

Advanced Playlists 

Unigraf UCD devices can also be used as a 

compatibility test tools for dedicated 

standards such as Dolby Vision™ and 

HDR10+. Contact Unigraf for details. 

Note: Note that Playlists and Scenarios are protocol dependent.   
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Common Tab 

The Import button is for importing *.json files into the common tab treeview. Sample content on 

windows can abe found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\ 

basic_library.json. Be warned that once imported, items cannot at present be removed. Actually you 

can but it involves using Windows Register Editor to remove values from (uninstall will not help): 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\Playback 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\MetadataScenario  

Sample playlists are included in UCD Console. Select a sequence (a scenario) from the playlists and    

press Run (or double click it) to play.  

The Run button lable changes to Stop as a Scenarios run. Press Stop to stop playing the scenario. 

Press Skip to skip to next scenario (available when there are multiple scenarios in a playlist) while 

playing. While the scenario is loading the Run button lable changes to Cancel to allow cancelation. 

Figure below shows a playlist being run that contains a prompt command which pops up a dialog. 

 

 

Status Log 

Scenario commands are listed in the Status Log  as they are run. 
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Selected Sequence 

Running scenario video and audio details and their sources are shown in the Selected Sequence 

group panel. 

Note that the triggered scenario or playlist to be run is the last selected: If an item was selected via 

the treeview, it is the triggered item to be run. If the Select button was used to select an item, it is the 

triggered item to be run (regardless of what is selected in the tree control). 

Press the Select button to load a playlist or scenario to be run (selecting a sample from the Sample 

Content treeview will load them as the playlist or scenario to be run). Also it will be the scanario used 

as a template if the Scenario Editor is launched: default scenario values will be set if a playlist is 

selected. 

Press the Editor button to launch the Scenario Editor (see below). 

The Selected Sequence parameters are the transmission stream parameters. 
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Scenario Editor 

 Press the Select button above to select the scenario desired to use as a template for creating a new 

scenario. Press the Editor button to launch the Scenario Editor. The the dialog paramaters will be 

generated from the scenario file shown under the panel Source label (Philips FHD.txt as seen above). 

Press the Path :…for setting the Video, Packets or Audio paths. 

Press OK to save. Your are presented with a save dialog. You need to navigate to a directory you can 

save to. Run Conssole 2 with administration rights if you want to save to default locations on 

windows such as: C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Refer to Appendix H: Playlists and Scenarios later in this manual for details. 
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Metadata Tab 

The Metadata  tab is for creating scenarios with metadata. 

 

 

Select the Delete button to delete a scenario or the Generate button to launch the Custom Metadata 

Scenario dialog (shown below). 

 

Current Pattern Generator timing details are shown at the top. You can change the color mode 

(RGB444, YUV444, YUV422, YUV420) and color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc) via the 

dropdown combo boxes. 

Select the Add or Delete buttons to add or remove metadata from the scenareio. 

Check the Audio checkbox and then the Browse… button to add an audio file. Sampling, channels 

and bits can be selected via the combo boxes. 

The scenario Comment can be added in line edit box after the three dashes (---). 

Use the Content folder Browse… button to select save location. 

You can press Play to run the scenario, Export to save it or Cancel to cancel. 

Export will  create a folder something like Metadata1920x1080@60-RGB444-8bpc in the Content 

folder. In it you will find  generated files frame.svg (displaed while running), the metadata files you 

selected and a scenario.txt file. You may edit and rename these files. 

. 
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HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description of the tab. 

VRR/QMS tab 

 

Click Generate to generate custom VRR and QMS scenarios. Custom Scenario Generator window 

will open. 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 
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VRR settings 

In the VRR tab you can set the transition and scenario duration parameters. Different transition types 

are Fixed frame rate, Min and max and Gradual. When fixed frame rate is selected, the scenario is 

played at the minimum frame rate set in the first field. Please, note that when the fixed frame rate is 

selected, you can only select the number of times the frame is repeated. 

 

When min and max is selected, the output sceario will alter the framerate between the specified 

values. You can also set the duration for step in seconds and select how many times frames are 

repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

QMS settings 

In the QMS settings dialogue you find all the frame rates included in the QMS specification. Select 

which frame rates you want to inlcude in your scenario. Also select the step duration in cycles. In the 

lower left corner details of the scenario as shown. 
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Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop-down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse… Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clicking Play. When the scenario is ready for playing, the scenario 

generator window will close. You can now inspect the progress in the log in the playback tab as shown 

below. 

Adaptive-Sync tab 

 

Click Generate to generate custom Adaptive-Sync scenarios. Custom Scenario Generator window 

will open. 
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First you are asked to select the floder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 

 

Adaptive-Sync settings 

In the Adaptive-Sync section you can set the transition and scenario duration parameters. Different 

transition types are Fixed frame rate, Min and max and Gradual.  

When fixed frame rate is selected, the scenario is played at the minimum frame rate set in the first 

field. In scenario duration, select how many times frame is repeated. 
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When min and max is selected, the output scenario will alter the framerate between the two values 

set in the drop down menus. You can also set the duration for step in seconds and select how many 

times frames are repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop-down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse… Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clickin Play. When the scenario starts playing, the scenario generator 

window will close. You can now inspect the progress in the log in the palyback tab as shown below. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV format. 

Audio is played to all active ports. 

To load internally generated audio, select Generate Audio, and adjust the controls to the desired 

audio format. 

To load an audio file from your PC, select Load Audio from File, click the Open WAV file… button, 

browse and select the file and Open. 
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The Compressed checkbox indicates that the audio loaded from the selected file is compressed. 

To play the selected audio content, click the Play. 

The content will be transmitted until the Stop button is clicked.  

Audio Status displays current audio content status.  

Audio Content 

Sent audio can be generated internally or used a WAV file loaded from the PC. 

In case of a WAV audio file, the parameters stored in the file will be used. When generating audio 

internally, the user sets the details of the LPCM Audio signal. 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental 

Signal Frequency Setting audio signal frequency in Hz. 

Sample Rate (Hz) Selection of audio sampling rate: 32000, 44100 (default), 48000, 

88200, 96000, 176400, 192000. 

Bits/Sample Selection of sample bit depth: 16, 20, 24. 

Amplitude(%)       i       u i    p i u  : 1 %, 2 %, …, 9 %, 1  %. 

Channels Audio channels available: 1, 2, …, 7, 8  

Channels transmit LPCM (uncompressed) Audio. 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 
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Status General 

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded: HDCP keys are loaded to the UCD unit. 

Km is stored: Master Key (Km) is stored. 

SST Mode Type Type when in SST mode. 

Status By stream 

Stream status (DP) shows HDCP status on each stream. 

Configuration Control 

Enable encryption: Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Use stored Km: Use stored Master key (Km). 

Configuration type 

Select to configure HDCP (DP) or All streams at once or By stream. 

By stream 

Select and configure streams (DP). 

Type Value 

Select Type 0 or Type 1. Type 1 ensures that content encryption is done with HDCP version 2.2 or 

higher. 

Configuration Keys 

Select Production or Facsimile HDCP keys. To remove the keys, select None.  
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EDID Tab 
EDID Tab provides tools for accessing the EDID data of the connected sink device. There are three 

basic functions: 

• Load and save the data files in the host PC. 

• Edit the data contents either in Editor Mode or in Hex Edit Mode. 

• Read and write data to the connected sink. Up to 4 virtual channels can be accessed. 

EDID Files 

With Load… and Save As… a file can be read into the editor or written to a file from the PC.  

The contents of the device EDID file are not modified, or integrity checked during load and save 

operations. 

Note: Four blocks (512 bytes) of EDID code are read. If the device does not support all four blocks, the 

non-supported data values are set to zero. 

Text EDID 

In the Editor Panes (upper right pane), the Text EDID tabs allow viewing data in tree form. 

EDID/DisplayID Editor 

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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Packet Generator 
Packet generator enables configuring and generating Custom SDP independently from the Audio and 

Video Pattern Generators.  

Note: In Packet Generator the packet generation time is limited. After limitation generator must be restarted 

manually. For UCD-422 the limit is approximately 8 hours. 

 

 

Add: Add new packets. Opens packet editor. 

Edit: Edit existing packets 

Remove: Remove selected packet 

Remove All: Remove all packets 

Start: Start transferring the packets 

Presets: Save, Load, Remove, Import or Export packets 

Save as… Save packet 

Load: Load packets 

Packet editor 

For detailed information on the packet editor, please refer to Packet Editor chapter in this manual. 

 

Sink DUT Testing Tab 
Refer to Appendix E for descriptions of the tests available. The tests are presented in a split view, the 

left being test categories and the right being the tests within.  
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Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category (ex. DP 

1 .4 LL CTS) when running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 
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Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 

 

On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

• Save parameters in Configure dialog as Presets later to be used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that importing and Exporting *.json files here have a different format than importing 

those described above. 
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 HDMI LINK TIMELINE VIEWER 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

 

HDMI Link Timeline Viewer is a tool for evaluating the content and timing of data captured via HDMI 

Link Analyzer functionality of UCD Console. 

HDMI Link Timeline Viewer has three tabs (for three modes):  

FrameView tab is the primary tab for analyzing captured events on the timeline. 

Reports tab can be used to summarize events (AUX at present). 

Images tab lets the user view captured video frame images. 

 

 The FrameView tab and its views are shown below. 
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Wave Form View zoomed out and zoomed in views are shown below. Event periods are shown under 

the timeline (at the top) in their proper row as period rectangles with text descriptions (or abbreviations 

or no text, space permitting). Double-clicking a period rectangle will highlight the timeline portion of 

the rectangle and the row header(s) as shown below. To zoom the Wave Form View, position the cursor 

and use the mouse wheel to zoom in or out with respect to the cursor location. Drag to scroll the Wave 

Form View and the Symbols View horizontally.  
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Wave Form and Symbols View Settings 
Shown below are the WaveForms View and Symbols Views settings widgets. 

 

Gear Icon 

 

Select the Gear icon to select events to be displayed (+) or hidden (-). When Gear icon is selected, 

you can drag a row to reorder rows. 

 

 

Save Icon 

 

Select the Save icon to Save, Load or Remove named internal settings sets. You can also Import or 

Export named *.json files containing settings or Reset to default. 
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Zooming 

 

Select  Zoom + or – icons to zoom in and out or use the mouse wheel. The zooming in/out option 

applies to Wave Form View only. 

Scrolling 

 

Use the arrow keys to navigate the timeline. One arrow moves the timeline one page, two arrows 10 

pages and three 100 pages. 

You can also scroll by dragging ( click and hold while dragging).  

Clock icon 

 

Move to a time point. Enter values and press OK. 

 

Eraser 

 

Removes all measurements on the timeline. 

 

Move to Previous or Next Frame 

 

Move back or forward to the same relative location in the previous or next frame. 

Sync Data 

   Not synchronized.     Synchronized. 
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     Vi w T   

Frame View tab has three tabs: Main Link Events, Symbols, and Log Events. 

The Main Link Events tab is the primary tab for analysis and is presented first. 

Main Link Events Tab 
Main Link Events tab consists of five panels: Event Selector View, Event Details View, Wave Form 

View, Symbols View and Frame Image View. 

Each of these views are synchronized and actions in one will be reflected in others. 
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Event Selector View 

Event Selector View events are presented as a folding list of FRAMEs. Each FRAME contains a set of 

BLANK LINEs followed by a set of ACTIVE LINEs and finally by another short set of BLANK LINEs. 

BLANK LINEs contain items such as CTR periods and DATA ISLAND periods. DATA ISLANDs contain 

HDMI data packets such as GCP and AVI packets.  ACTIVE LINESs contain CTRL and VIDEO DATA 

items. 

 

 

 

The timing format used in Link Timeline Viewer consists of two timings based on time and bits. 

The time format is as follows:  

seconds:milliseconds.microseconds.nanoseconds.picoseconds 

In the image above you can see the time format on top and the bit format underneath (smaller grey 

font). 

When clicking on a Main Link Event, both Wave Form View and Symbol View are focused, and the 

time stamp block of the item is highlighted as shown below. 
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Event timing details are shown in the columns are the following: 

Type: Type of item. 

Id: Items occurrence number. 

Position: Start of the event from start of the captured data 

Duration: Duration of the event 

End: End of the event from start of the captured data 

Search 

You can search events by typing its name in the Search bar and pressing enter or by 

clicking the enter icon. The events are highlighted and shown in Wave Form View and 

Symbol View. 

 

 

 

 

Aa: Makes search function case sensitive. 

RExp: Use regular expressions. 

 

Click the enter icon to apply filters. 

 

 

Click Find Prev and Find Next icons to navigate. Also shown is the instance (here 

instance 2 out of 77). 
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The gear icon opens Configure search dialog. In addition to settings described above, 

you can select which colums are shown in Main Link Events window. 

 

 

 

   Not synchronized.     Synchronized. 

Click icons to synchronize data for view. 
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Symbols Tab 
Symbols View lists all PERIODS. 

 ‘ 

 

 

Selection and multiview highlighting behavior is as for Main Link Events above. 

Search criteria are the same as for Main Link Events above. 

Each column has a sort and filter icon. Shown below is for the Type sort and filter icon. 
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Event Details View 
The event details are shown in the lower left panel. The event details consists of two tabs: Image tab 

and Details tab. 

Details Tab 

The information shown in the Details tab depends on the selected item. A FRAME item is shown 

below. 

  

Images Tab 

 

Image for currently selected FRAME can be viewed (only when FRAME is selected). 
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Wave Forms View 
Wave Form View consists of two tabs: Wave Forms and Spatial View. 

Wave Forms Tab 

Wave Form View looks different depending on zoom level. Images below show the views in zoomed 

out and zoomed in states. 

Event periods are shown under the timeline (at the top) in their proper row as period rectangles with 

text descriptions (or abbreviations or no text, space permitting). Double-clicking a period rectangle 

will highlight the timeline portion of the rectangle and the row header(s). To zoom the Wave Form 

View, position the cursor and use the mouse wheel to zoom in or out with respect to the cursor 

location. Drag to scroll the Wave Form View and the Symbols View horizontally. 
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Columns are: 

HPD Hot Plug Detect signal. 

I2C I2C Events and signals sda and scl 

CEC: CEC Events and Signal 

Link Link type (TMDS SCRAMBLED for ex.) 

Periods INVALID, CTL, DATA, VIDEO, SSCP, HDCP, KEEP_OUT 

Sync HSYNC and VSYNC periods and signals 

Frame Frame number. 

Lines ACTIVE and BLANK lines 

Packets GCP and AVI packets 

PHY Lane 0 Lane 0 data 

PHY Lane 1 Lane 1 data 

PHY Lane 2 Lane 2 data 

 

The scroll bar at the top shows all captured frames. Select a frame by double-clicking. 

 

 

As you hover over the timeline, a timestamp for that position is displayed on the timeline at the cursor 

horizontal location. 

Popups show details of events as you hover over them in Wave Form View. 

Below illustrates how the different views align when you double click in the Wave Form View or the 

Symbols View. 
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Measuring 

The ruler tool allows users to measure the time between two points on the timeline. When you right 

click on the timeline, a point willl appear. Right click again on the timeline and the distance between 

the two points will be shown as illustrated below. Use the eraser tool to remove measures. 

 

Spatial View Tab 

Frame pixel images are shown in Spatial View. 

Drag to scroll Frames. 

Double-clicking the timeline when Spatial View Tab is active will select the event in Event Selector 

View. 

A popup showing details will be shown when hovering over a Frame or HDMI data packets such as 

GCP and AVI. 

Hover over an event to see event details in a popup window. Double-click an event will to select it in 

and see details in Event Details View. 
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Symbols View 
Like Wave Form View, Symbol View presents HDMI transmission data and periods. As with Wave 

Form View, drag to scroll horizontally or use the settings ribbon arrow keys. 

Periods Transmission PERIODs 

Sync Horiz and Vert periods 

Frame/Lines Frame and Line number 

Packets HTML GCP and AVI packet identifiers 

Symbols HDMI transmission symbols. 

Phy Lane 0  TMDS Channel 0 data. 

Phy Lane 1  TMDS Channel 1 data. 

Phy Lane 2  TMDS Channel 2 data. 

 

Illustrated below are the TMDS channel values for PIXELs for the color white. Note from the tool tip 

that the value has been scrambled. 

 

 

Illustrated below are the values for a SSCP period. Note from the tooptip that this is not scrambled. 

 

 

Each individual block contains the following information (tooltiup also shown). 

First row 10b/8b symbol in HEX format 

Second row Descrambled value. 
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Frame Image View 
Frame Image View can be used to select Frames and GCP or AVI periods and synchronizing with 

other views. 

As shown below, selecting the AVI event in Frame Image View also selects it in Event Selector View 

and synchronizes the other views. Hovering over the Active0 area will show the frame geometry 

details. 

Mode can be Image or Rect (shows just a green rectangle to save processing time). 

Stream combobox and Simple view checkbox do not work at present. 
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 EVENT TIMELINE VIEWER 
Event Timeline Viewer is an application for inspecting data captured in capture tab. 

Event Timeline Viewer consists of four areas. 

1. Frame View 

2. Event View 

3. Event Log 

4. Details / Image 

 

Frame View 

 

The uppermost panel shwos the captured frames. The selected frame is highlighted in purple. You can select a 

frame by double-clickin it. The area highlighted in green indicates the area shown in the Events view. Please, note 

that you cannot zoom in or out in the frame view. 

Event View 

 

The view below shows all frames and events selected in the capture tab. The are highlighted in green in frame view 

indicates the are shown in events view. 

  

1 

2 

3 

4 



  Event Timeline Viewer 

UCD-4XX User Manual • UCD Console 3.9 108 

Tools 

Tool Function 

 Gear Icon Hide / add events on the timeline 

 Save Icon 
Save, load, remove, import, export and 

remove presets 

 Magnifying Glass Icons Zoom in/out on the timeline 

 Arrow Icons 

Move on the timeline. More arrows moves 

the timeline more. You can also move by 

clicking and dragging on the timeline. 

 Move to a time point 

Move to a certain time point on the timeline 

by double clickin on the timeline. The 

selected event is highlighted in the event 

log. By right clicking on the timeline and 

right clicking again you can measure 

distance between two time points. 

 Erase all rulers Erase all measurements made. 

 

Zooming on the timeline

 

Went the timeline is zoomed out, you can see events as grey lines. When you zoom in you can see 

the event block. You can zoom in either with the magnifying glass icons or by scrolling with your 

mouse. 

 

When you double click on event or frame, the correseponding event or frame is selected in the event 

log and highlighted in purple. 
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Event Log 

 

Event log shows all captured events and frames. The following info is presented in the table: 

Type Function 

ID Number of captured frame 

Start Start of the event 

Duration Duration of the event 

End End of the event 

Info Additional information about the event. 

 

Event Log Tools 

 Search  
Search events from the event log. Search 

results are highlighted in purple. 

 Apply search filters Apply filters. 

 Search filters 
Aa filter: Make search case sensitive 

RExp: Use regular expressions in search 

 Search results 

Shows search results. Move from one 

search result to another by clicking the 

arrows. 

 Configure 
Selec which columns are shown in event 

log. 
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Details / Image 

 

Details tab shows details of the selected event. When the selected event is a frame, the image tab 

shows the captured frame. 
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 EVENT LOG 
Event Log dialog is divided into two panels: the left panel lists all transactions, and the right panel 

shows the parsed transaction data for the line selected in the list on the left. 

 

 

  



  Event Log 

UCD-4XX User Manual • UCD Console 3.9 112 

 

 

Role Logged Events 

DP Sink (UCD-400) 

DP Alt Mode Sink (UCD-424) 

HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW, 

VFRAME INFO 

HDMI Sink (UCD-422) HPD, Packets, I2C, CEC 

DP Source (UCD-400, UCD-411, 451) 

DP Alt Mode Source (UCD-424) 

HPD, AUX 

HDMI Source (UCD-422, UCD-412, 452) HPD, I2C, CEC 

DP Alt Mode Sink (UCD-424) 

DP Alt Mode Source (UCD-424) 

PD, LSE 

 

Start Starts event logging and stop it by clicking Stop. 

Save Save transactions as Event Log data. 

Loa Load Event Log data. 

Repor Store event logs as reports in HTML format. 

Open Timeline Viewer Open Event timeline Viewer to inspect the captured data. For detailed 

instructions refer to chapters 6 and 7 of this manual. 

AutoScroll When selected, transaction list is scrolled vertically. The latest transaction 

is shown as the last item of the list. When not selected, the items shown 

before clicking Start will be shown. 

Events Number of events detected. 

Colors Open configure colors dialog. 

Clear/Clear on Start Click to clear transaction list. When Clear on Start is selected, the list is 

cleared when clicking Start. 



  Event Log 

UCD-4XX User Manual • UCD Console 3.9 113 

  



  Event Log 

UCD-4XX User Manual • UCD Console 3.9 114 

Logged Events  

HPD 

Status and status changes of Hot Plug Detect (HPD) signal, power detection status and cable 

connection status. 

AUX 

DP Log DP AUX Channel transactions and Sideband Messaging. 

SDP 

Log DP Secondary-data Packets. Click the button to open the Event Filter Dialog. The dialog 

enables filtering of SDP packets. In the dialog, the reference to Packet Type Value is indicated in 

square brackets “[ ]”. 

VB-ID 

Log Vertical Blanking ID packets sent in DP stream. Click the button to open the Event Filter Dialog. 

The dialog enables definition of which events will be logged. 

MSA 

Log Main Stream Attributes sent in DP stream. Click the button to open the Event Filter Dialog. The 

dialog enables logging of all MSA:s or just changes to selected parameters. 
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Link Pattern 

Click the button to open the Event Filter Dialog. 

Log link patterns. Event filter dialog sets the type of link patterns that will be captured.  

Custom Pattern (80 bit) is a squence that either splits into 10 bytes or 8b/10b encoded symbols. For 

10b symbols, either K/D codes or hex values must be provided. For bytes, hex values must be 

provided. 

 

AUX_BW 

Log AUX_Bitwise transactions as a series of Manchester II codes. 

VFRAME INFO 

Dimensions of the catured frame measured by the Sink.  

Packets 

Log metadata sent by Source device in HDMI stream. 
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I2C 

Log data sent over I2C communication lines of HDMI interface. Click the button to open the Event 

Filter Dialog (either HDMI RX or HDMI TX dialogs). 

 

PD 

Log USB-C PD communication messages. 

 

 

CEC 

Log HDMI CEC communication messages. 

LSE 

Low Speed Electrical logger captures the Voltage and Current on the low-speed lanes of the  

USB-C connector including CC, VBUS, VCONN, and SBU. 

Event Filter Dialog sets the threshold values for capturing the changes. Parsed transaction data shows 

the captured data with indication of the changed values. 
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Event Transaction List 
Transaction data in Transaction List is ordered in columns. Each column provides additional 

information about the data line, facilitating its viewing and interpretation. 

You can search events by typing its name in the Search bar and pressing enter or selecting the 

Search button. Pressing F3 (Ctrl+G on macos) takes you to the next found and Shift+F3 (Shift+Ctrl+G 

on macOS) takes you to the previous found. 

 

Source: The communication port: DP RX, DP TX, HDMI RX, HDMI TX or HDCP 1.X, HDCP 2.3 

Type: The logged item:  

HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW, VFRAME INFO (DP or DP Alt 

Mode) 

HPD, Packets, I2C, CEC (HDMI) 

Start: Each line is identified by its timestamp, marking the instant when an event or error was 

detected, or when a data transaction got started.  

The timestamp can be displayed as a time delay from the start of the acquisition 

(absolute) or from the previous line (relative). The timestamp can be displayed in 

milliseconds or in minutes, seconds, and microseconds. 

Info: This column provides a short description of the message content 

 

When hovering the mouse over the transaction list, a mouse-over window will open. It provides a brief 

list of the content in the transaction under the mouse. 
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Customizing Transaction List 
User Can change what data is shown in the transaction list by adding and removing columns or 

limiting the transaction types in the list. User can also color highlight various types of transactions for 

better readability. 

Right-click on the list to open the menu. 

Configure Start 

The time indicated in column Start can be either: 

• Time from device reboot 

• Time from previous event 

The time can be expressed either: 

• In microseconds (1/1 000 000 Second) 

• Hours : minutes : seconds : milliseconds : nanoseconds 

Configure Colors 

Configure colors dialog allows the user to highlight various types of transactions in the list by changing 

character color and background color of the transaction line. 

Add: Add a new color highlight rule 

Config: Modify the selected rule 

Remove: Delete the selected rule 

Clone: Duplicate the selected rule 

▲: Change order where rules are applied.  

The rules are applied from the bottom to the top of the list. 
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Adding Rules 

The color highlight rules are set by transaction type. The content of Add rules dialog is dependent on 

the type of item selected. 

Configure Columns 

In the dialog there are two columns: Available and Active. An item from Available list can be included 

in Active columns by selecting it and clicking on the right arrow [>] in the middle of the two columns. 

The order of Active items can be changed by selecting an item and moving its position in the list with 

up ▲and down ▼ arrows. 

Type Filter 

Type filter dialog lists the types of transactions found in the list and allows the user to select which 

transaction lines are currently shown. 

Quick Filter 

By entering a DPCD address in the Quick Filter field on top of the transaction line, the user can limit 

the list to show only the reads or writes to this DPCD address. 
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Event Details 

HPD 

HPD transactions include the following statuses: 

Hot-Plug-Detect Level: Status of HPD signal: HIGH (Asserted), LOW (De-asserted) 

PWD Level: Status of source device detection: High (DP Tx detected),  

LOW (DP Tx not detected) 

Cable Detect Level: Status of cable detection HIGH (Cable connection detected) LOW 

(Cable connection not detected) 

Packets (UCD-422, UCD-452) 

Log metadata sent by Source device in HDMI stream 

 

I2C (UCD-422, UCD-452) 

 Log data sent over I2C communication lines of HDMI interface 



  Event Log 

UCD-4XX User Manual • UCD Console 3.9 122 

CEC (UCD-422, UCD-452) 

CEC messages 
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 EDID EDITOR 
The EDID Editor main window is divided into three views. The bottom area additionally has command 

buttons. The top left tree view selection determines the blocks to be edited. The top right view shows 

data for the currently selected item in the top left view. These values may be edited when the Editor 

Mode checkbox is checked,  The bottom right hex view shows that data as hex values. The hex values 

of the currently selected item in the top left view are highlighted. Values can be edited when the HEX 

Edit Mode checkbox is checked. 

Add Item Add a new EDID block. Available when in Editor Mode exclusivly and a 

top node in treeview (CTA or VESA) is selected. 

Remove Item Delete the selected EDID. Available when in Editor Mode exclusivly and a 

top node in treeview (CTA or VESA) is selected. 

Filter Show only items having the filter string in the field name. 

Editor Mode See below. 

Show Read Only Automatically generated non-editable fields are additionally shown. 

Read mode Data read mode: 

I2C (using I2C protocol) or SBM (MST mode only): virtual channels read 

via SBM protocol. 

Recurse All subitems of the selected item are presented in Editor View. 

Virtual Sink #1 (DP) Dropdown labled with the currently selected virtual sink (MST). 
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The buttons at the bottom of the dialog differ based on role:  Analyser (Read fromTE and Write to TE)  

or Generator (Download from Sink and Upload to Sink). 

  

Read from TE (Analyzer) Read device local EDID blocks into editor (HEX Edit Mode 

must be unchecked). 

Write to TE (Analyzer Write editor data to device local EDID blocks. 

Download from Sink (Generator) Read EDID blocks from connected sink device into editor. 

Upload to Sink (Generator) Write editor EDID blocks to connected sink device.  See note 

below. 

Editor Mode Enable editing EDID content in top right view. For example, 

for testing purposes, i ’  p   i            i v  i  

EDID/DisplayID data and write it to TE without modifications. 

Once Editor Mode is enabled, the validator corrects errors 

such as invalid checksums.  Top right view name-value paiars 

can be edited. 

HEX Edit Mode Enable editing EDID content in bottom right HEX  view. When 

enabled, HEX values may be edited. Click Apply to validate 

changes and update other views. 

Save As… Save the current editor data to disk in various formats: 

binary, hex, ecd, txt and xml. 

Load … Load EDID/DisplayID data from disk. Same formats as above 

available. 

  

Note: A source device is always able to read EDID data of the connected Sink device. The connected sink 

device may or may not allow its EDID content to be modified. 
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Select the Main Features button to view items of common 

interest. For example, whether the sink is capable of HDR, or 

Dolby Vision, etc.  

 

 

 

The Main Features view CTA v3 tab (avalable only in EDID tab 

not DisplayID tab) allows enabling/disabling features. You 

enable/disable a feature by selecting the Value field with 

Editor Mode enabled  (AND HEX Edit Mode disabled). When a 

value is disabled and you want to enable it, the Editor View 

will be blank as focus has been set on the values to be 

enabled (and are zero when disabled). New highlighted hex 

values will be added and highlighted in the lower right Hex 

View. New node data will also appear under the CTA node in 

the top left tree view. 

 

 

 

EDID Editor Features 
A practically unlimited number of extension blocks may exist in a single collection. Most EDID blocks 

contain a structure that is very similar to a tree structure. The Editor decodes each block into a tree 

view of the block. The tree view then contains all values within the data block. Contents can be 

browsed. The Editor has a support for automatic variables, such as the block checksum. When a 

value in a block is modified, the checksum will be updated. Automatic variables are read only. A log 

print will be made when an automatic variable is updated by the editor.  

Editing Tips 
Editing is straightforward: 

Select property fields to edit. 

Red values in HEX View show that values have been modified. 

Press Enter to apply edit values and combo box selections. 

In CTA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte  escriptors in this block” and “ EA  ata block count”.  
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Enter hex values with prefixes “0x” or “$”.  No prefix represents a decimal value. 

Values may be entered as hexadecimal or decimal regardless of  presentation. 

Floating point values must have a period “.” decimal separator. 

Click Set after changing a bit-value presented as a single checkbox if you want the new value 

applied. 

Note: EDID Editor does not have an Undo function. Therefore, it is highly recommended that you back up 

un-edited EDID contents to a file before editing it. 
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 PACKET EDITOR 
Packet Editor enables creation and editing metadata packets. 

The types of supported packets are: 

• Audio InfoFrame (Audio) 

• AVI InfoFrame (AVI) 

• Custom InfoFrame (Custom) (HDMI) 

• Custom Packet (Custom) (DP) 

• DR&M InfoFrame (DR&M) (HDMI) 

• DR&M Packet (DR&M) (DP) 

• EMP-VRR (EMP-VRR) 

• GCP InfoFrame (GCP) 

• SBTMEM Source-Based Tone Mapping Extended Metadata (HDMI) 

• SPD InfoFrame (SPD) 

• Vendor-Specific InfoFrame (VS) (HDMI)* 

• Vendor-Specific SDP (VS) (DP)* 

 

*) Please select from available VS packet types in field “ : Type” in the packet editor. 
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 PATTERN EDITOR 
Pattern Editor is a tool for editing and debugging Unigraf Custom VTP Pattern scripts. 

Please refer to APPENDIX F: VTP PATTERN LANGUAGE later in this document for description of the 

VTP Pattern Language syntax. 

Pattern Editor consists of three tabs: 

Image Tab 

Monitoring the rendering of the VTP pattern script. 

Source Tab 

Tool for editing VTP Pattern Language script. Click Apply to render the code in the resolution of the 

preview image in Image tab. 
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Logs Tab  

Log of the pattern code parsing indicating the values assigned to logical variables and the actual 

parameter values used for render instructions. 

Saving and Recalling the Script 

In File pull-down menu the user can save his work. 

Open: Open a VTP language script from PC 

Save Script: Save the script currently in Source tab to PC 

Save Image: Save a rendered pattern in PNG, BMP, JPG or PPM format 

Select Save Resolution: Select from six common resolutions the size in which the pattern script will 

be rendered when saved. 
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 IMAGE CONVERTER 
Image Converter is a tool for converting images from one color format to another. This kind of 

conversion is typically needed when creating YCbCr test images from RGB bitmaps. 

Image Converter has two operating modes: Standard mode and Advanced mode. In Standard mode 

typical image file formats are used as Source image and the user sets basic color formats for the 

Destination image. In Advanced mode, the user is able to define the Source and Destination image 

parameters in detail. 

Click Select to load the Source image. Click Convert to store the Destination image. File name for 

the Destination image is of form: 

Source_image_1920x1080_8bits_yuv444_lsb.bin 

  

Source_image Name of the image file used as Source image 

1920x1080 Resolution of the Source Image 

8bits Bit depth of the Destination image 

yuv444 Color space and sampling of the Destination image 

lsb Data alignment of the Destination image 

 



  Appendix A: Product Specification 

UCD-4XX User Manual • UCD Console 3.9 131 

APPENDIX A: PRODUCT SPECIFICATION 

UCD-422 and UCD-412 
Input HDMI 2.1 (10K@30Hz) (HDMI Rx) (UCD-422 only) 

Output HDMI 2.1 (10K@30Hz) (HDMI Tx) 

HDMI 2.1 Features FRL, TMDS, ALLM, VRR, QMS-VRR, SBTM 

Content Protection HDCP 2.2, HDCP 2.3 

Additional features eARC, DSC*, FEC* 

Computer interface USB 3.0 

Operating System Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 272 × 170 × 60 mm 

Weight 1.2 kg w/o power supply 

*) Please contact Unigraf for detailed availability 
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APPENDIX B: PRODUCT FEATURES 

UCD-422 Gen2, UCD-422 and UCD-412 Features 

    Input / Output Role U
C

D
-4

X
X

 D
e
fa

u
lt
 

H
D

M
I 
1
.4

 L
in

k 
A

n
al

yz
e
r 

T
S

I 
B

as
ic

 

HDMI Reference Sink (UCD-422 only)      

Video status, preview and saving ●  ▲ 

Buffered capture ●   

Audio monitoring, graphical preview and saving ●  ▲ 

Link status ●  ▲ 

Link control ●   

HPD status and control ●  ▲ 

EDID read and write ●  ▲ 

EDID Editor ●   

HDCP 1.4 status and control* ●  ▲ 

HDCP 2.3 status and control* ●  ▲ 

FEC Feature ●  ▲ 

DSC Decoder, DSC Control ●   

ALLM, VRR ●  ▲ 

Event Log ●   

InfoFrame status ●  ▲ 

Source DUT Testing ●  ▲ 

HDMI 1.4 Link Analyzer  ●  

 

HDMI Reference Source      

Video pattern generator (fixed patterns and timings) ●  ▲ 

Custom video patterns and timings ●  ▲ 

Playback ●  ▲ 

Audio Generator ●  ▲ 

Link status ●  ▲ 

Link control ●  ▲ 

EDID read and write ●  ▲ 

EDID Editor ●   

DSC Encoder ●   

SCDC Editor ●   

Event Log ●   

Sink DUT Testing ●   

HDCP 1.4 status and control* ●  ▲ 

HDCP 2.3 status and control* ●  ▲ 
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Product Options 

UCD-412, UCD-422, UCD-422 Gen2 Product Options 

 

Product P/N 

HDR10+ DD and SSTM Tests for HDMI Sink DUT MT6675 

HDR10+ DD and SSTM Tests for HDMI Source 

DUT 
MT6677 

HDMI 1.4 Link Analyzer MT6658 
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APPENDIX C: PREDEFINED TIMINGS 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CVT 640 × 480 @ 60 Hz   640 480 800 525 144 35 96 2 60 25,20 

CTA 640 × 480 @ 60 Hz (VIC 1) 640 480 800 525 144 35 96 2 60 25,17 

CTA 720 × 480 @ 60 Hz (VIC 2) 720 480 858 525 122 36 62 6 60 27,03 

CTA 720 × 480 @ 60 Hz (VIC 3) 720 480 858 525 122 36 62 6 60 27,00 

CTA 720 × 576 @ 50 Hz (VIC 17) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 50 Hz (VIC 18) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 100 Hz (VIC 42) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 576 @ 100 Hz (VIC 43) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 480 @ 120 Hz (VIC 49) 720 480 858 525 122 36 62 6 120 54,00 

CTA 720 × 480 @ 120 Hz (VIC 48) 720 480 858 525 122 36 62 6 120 54,05 

CTA 720 × 576 @ 200 Hz (VIC 52) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 576 @ 200 Hz (VIC 53) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 480 @ 240 Hz (VIC 56) 720 480 858 525 122 36 62 6 240 108,00 

CTA 720 × 480 @ 240 Hz (VIC 57) 720 480 858 525 122 36 62 6 240 108,00 

DMT 800 × 600 @ 60 Hz (ID Eh) 800 600 1056 628 216 27 128 4 60 39,79 

DMT 848 × 480 @ 60 Hz (ID 14) 848 480 1088 517 224 31 112 8 60 33,75 

DMT 1024 × 768 @ 60 Hz (ID 10h) 1024 768 1344 806 296 35 136 6 60 65,00 

CTA 1280 × 720 @ 50 Hz (VIC 19) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 41) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 24 Hz (VIC 60) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 61) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 62) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 24 Hz (VIC 65) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 66) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 67) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 50 Hz (VIC 68) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 60 Hz (VIC 69) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 70) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 120 Hz (VIC 71) 1280 720 1650 750 260 25 40 5 120 148,50 

CTA 1280 × 720 @ 48 Hz (VIC 108) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 48 Hz (VIC 109) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 60 Hz (VIC 4) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 120 Hz (VIC 47) 1280 720 1650 750 260 25 40 5 120 148,50 

CVT 1280 × 768 @ 60 Hz  [RB1] 1280 768 1440 790 112 19 32 7 60 68,26 

DMT 1280 × 768 @ 60 Hz (ID 17h) 1280 768 1664 798 320 27 128 7 60 79,67 

DMT 1280 × 800 @ 60 Hz (ID 1Bh) [RB1] 1280 800 1440 823 112 20 32 6 60 71,11 

DMT 1280 × 800 @ 60 Hz (ID 1Ch) 1280 800 1680 831 328 28 128 6 60 83,76 

DMT 1280 × 960 @ 60 Hz (ID 20h) 1280 960 1800 1000 424 39 112 3 60 108,00 

DMT 1280 × 1024 @ 60 Hz (ID 23h) 1280 1024 1688 1066 360 41 112 3 60 107,96 

DMT 1360 × 768 @ 60 Hz (ID 27h) 1360 768 1792 795 368 24 112 6 60 85,48 

DMT 1400 × 1050 @ 60 Hz (ID 29h) [RB1] 1400 1050 1560 1080 112 27 32 4 60 101,09 

DMT 1400 × 1050 @ 60 Hz (ID 2Ah) 1400 1050 1864 1089 376 36 144 4 60 121,79 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

 



  Appendix C: Predefined Timings 

UCD-4XX User Manual • UCD Console 3.9 135 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 1440 × 240 @ 60 Hz (VIC 8) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 240 @ 60 Hz (VIC 9) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 480 @ 60 Hz (VIC 14) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 480 @ 60 Hz (VIC 15) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 22) 1440 576 1728 625 264 22 126 3 50 54,00 

CTA 1440 × 288 @ 50 Hz (VIC 23) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 288 @ 50 Hz (VIC 24) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 576 @ 50 Hz (VIC 29) 1440 576 1728 625 264 44 128 5 50 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 30) 1440 576 1728 625 264 44 128 5 50 54,00 

CVT 1600 × 1200 @ 60 Hz  [RB1] 1600 1200 1760 1235 112 32 32 4 60 130,42 

DMT 1600 × 1200 @ 60 Hz (ID 33h) 1600 1200 2160 1250 496 49 192 3 60 162,00 

CTA 1680 × 720 @ 24 Hz (VIC 79) 1680 720 3300 750 260 25 40 5 24 59,40 

CTA 1680 × 720 @ 25 Hz (VIC 80) 1680 720 3168 750 260 25 40 5 25 59,40 

CTA 1680 × 720 @ 30 Hz (VIC 81) 1680 720 2640 750 260 25 40 5 30 59,40 

CTA 1680 × 720 @ 50 Hz (VIC 82) 1680 720 2200 750 260 25 40 5 50 82,50 

CTA 1680 × 720 @ 100 Hz (VIC 84) 1680 720 2000 825 260 100 40 5 100 165,00 

CTA 1680 × 720 @ 48 Hz (VIC 110) 1680 720 2750 750 260 25 40 5 48 99,00 

CTA 1680 × 720 @ 60 Hz (VIC 83) 1680 720 2200 750 260 25 40 5 60 99,00 

CTA 1680 × 720 @ 120 Hz (VIC 85) 1680 720 2000 825 260 100 40 5 120 198,00 

DMT 1680 × 1050 @ 60 Hz (ID 39h) [RB1] 1680 1050 1840 1080 112 27 32 6 60 119,23 

DMT 1680 × 1050 @ 60 Hz (ID 3Ah) 1680 1050 2240 1089 456 36 176 6 60 146,36 

DMT 1792 × 1344 @ 60 Hz (ID 3Eh) 1792 1344 2448 1394 528 49 200 3 60 204,75 

DMT 1856 × 1392 @ 60 Hz (ID 41h) 1856 1392 2528 1439 576 46 224 3 60 218,27 

CTA 1920 × 1080 @ 50 Hz (VIC 31) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 24 Hz (VIC 32) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 33) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 100 Hz (VIC 64) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 24 Hz (VIC 72) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 73) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 30 Hz (VIC 74) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CTA 1920 × 1080 @ 50 Hz (VIC 75) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 76) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 100 Hz (VIC 77) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 120 Hz (VIC 78) 1920 1080 2200 1125 192 41 44 5 120 297,00 

CVT 1920 × 1080 @ 30 Hz  [RB1] 1920 1080 2080 1096 112 13 32 5 30 68,39 

CVT 1920 × 1080 @ 30 Hz  [RB2] 1920 1080 2000 1096 72 14 32 8 30 65,76 

CVT 1920 × 1080 @ 144 Hz  [RB3] 1920 1080 2080 1157 152 14 32 8 144 346,66 

CVT 1920 × 1080 @ 200 Hz  [RB3] 1920 1080 2080 1190 152 14 32 8 200 495,21 

CTA 1920 × 1080 @ 30 Hz (VIC 34) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CVT 1920 × 1080 @ 60 Hz  [RB1] 1920 1080 2080 1111 112 28 32 5 60 138,65 

CVT 1920 × 1080 @ 60 Hz   1920 1080 2000 1111 72 14 32 8 60 133,32 

DMT 1920 × 1080 @ 60 Hz (ID 52h) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 16) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CVT 1920 × 1080 @ 120 Hz  [RB1] 1920 1080 2080 1144 112 61 32 5 120 285,54 

CVT 1920 × 1080 @ 120 Hz  [RB2] 1920 1080 2000 1144 72 14 32 8 120 274,56 

CTA 1920 × 1080 @ 120 Hz (VIC 63) 1920 1080 2200 1125 192 41 44 5 120 297,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 
Pixel Clock 

(MHz) 

CTA 1920 × 1080 @ 48 Hz (VIC 111) 1920 1080 2750 1125 192 41 44 5 48 148,50 

CTA 1920 × 1080 @ 48 Hz (VIC 112) 1920 1080 2750 1125 192 41 44 5 48 148,50 

DMT 1920 × 1200 @ 60 Hz (ID 45h) 1920 1200 2592 1245 536 42 200 6 60 193,62 

DMT 1920 × 1440 @ 60 Hz (ID 49h) 1920 1440 2600 1500 552 59 208 3 60 234,00 

CVT 2048 × 1536 @ 60 Hz  [RB1] 2048 1536 2208 1580 112 41 32 4 60 209,32 

CTA 2560 × 1080 @ 24 Hz (VIC 86) 2560 1080 3750 1100 192 16 44 5 24 99,00 

CTA 2560 × 1080 @ 25 Hz (VIC 87) 2560 1080 3200 1125 192 41 44 5 25 90,00 

CTA 2560 × 1080 @ 30 Hz (VIC 88) 2560 1080 3520 1125 192 41 44 5 30 118,80 

CTA 2560 × 1080 @ 50 Hz (VIC 89) 2560 1080 3300 1125 192 41 44 5 50 185,63 

CTA 2560 × 1080 @ 100 Hz (VIC 91) 2560 1080 2970 1250 192 166 44 5 100 371,25 

CVT 2560 × 1440 @ 60 Hz  [RB2] 2560 1440 2640 1481 72 14 32 8 60 234,59 

CVT 2560 × 1440 @ 60 Hz  [RB1] 2560 1440 2720 1481 112 38 32 5 60 241,70 

CVT 2560 × 1440 @ 144 Hz  [RB3] 2560 1440 2720 1543 152 14 32 8 144 604,57 

CVT 2560 × 1440 @ 200 Hz  [RB3] 2560 1440 2720 1586 152 14 32 8 200 863,09 

CTA 2560 × 1080 @ 48 Hz (VIC 113) 2560 1080 3750 1100 192 16 44 5 48 198,00 

CVT 2560 × 1080 @ 60 Hz   2560 1080 3424 1120 704 37 272 10 60 230,09 

CVT 2560 × 1080 @ 60 Hz  [RB1] 2560 1080 2720 1111 112 28 32 10 60 181,32 

CVT 2560 × 1080 @ 144 Hz  [RB3] 2560 1080 2720 1157 152 14 32 8 144 453,33 

CVT 2560 × 1080 @ 200 Hz  [RB3] 2560 1080 2720 1190 152 14 32 8 200 647,59 

CTA 2560 × 1080 @ 60 Hz (VIC 90) 2560 1080 3000 1100 192 16 44 5 60 198,00 

CTA 2560 × 1080 @ 120 Hz (VIC 92) 2560 1080 3300 1250 192 16 44 5 120 495,00 

DMT 2560 × 1600 @ 60 Hz (ID 4Dh) 2560 1600 3504 1658 752 55 280 6 60 348,58 

DMT 2560 × 1600 @ 60 Hz (ID 4Ch) [RB1] 2560 1600 2720 1646 112 43 32 6 60 268,63 

CTA 2880 × 240 @ 60 Hz (VIC 12) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 240 @ 60 Hz (VIC 13) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 27) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 28) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 480 @ 60 Hz (VIC 35) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 480 @ 60 Hz (VIC 36) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 37) 2880 576 3456 625 528 44 256 5 50 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 38) 2880 576 3456 625 528 44 256 5 50 108,00 

2880 × 1440 @ 60 Hz 2880 1440 2976 1456 48 8 8 1 60 259,98 

CVT 3440 x 1440 @ 60 Hz 3440 1440 4688 1493 992 50 368 10 60 419.951 

CVT 3440 x 1440 @ 60 Hz [RB1] 3440 1440 3600 1481 112 38 32 10 60 319.896 

CVT 3440 x 1440 @ 60 Hz [RB2] 3440 1440 3520 1481 72 14 32 8 60 312.787 

CVT 3440 x 1440 @ 120 Hz 3440 1440 4800 1545 1064 102 384 10 120 889.92 

CVT 3440 x 1440 @ 120 Hz [RB1] 3440 1440 3600 1525 112 82 32 10 120 658.80 

CVT 3440 x 1440 @ 120 Hz [RB2] 3440 1440 3520 1525 72 14 32 8 120 644.16 

CVT 3440 x 1440 @ 165 Hz 3440 1440 4832 1588 1080 145 384 10 165 1266.081 

CVT 3440 x 1440 @ 165 Hz [RB1] 3440 1440 3600 1559 112 116 32 10 165 926.046 

CVT 3440 x 1440 @ 165 Hz [RB2] 3440 1440 3520 1559 72 14 32 8 165 905.467 

CVT 3440 x 1440 @ 200 Hz 3440 1440 4848 1622 1088 179 384 10 200 1572.691 

CVT 3440 x 1440 @ 200 Hz [RB1] 3440 1440 3600 1586 112 143 32 10 200 1141.92 

CVT 3440 x 1440 @ 200 Hz [RB2] 3440 1440 3520 1586 72 14 32 8 200 1116.544 

CVT 3440 x 1440 @ 240 Hz 3440 1440 4848 1663 1088 220 384 10 240 1934.934 

CVT 3440 x 1440 @ 240 Hz [RB1] 3440 1440 3600 1619 112 176 32 10 240 1398.816 

CVT 3440 x 1440 @ 240 Hz [RB2] 3440 1440 3520 1619 72 14 32 8 240 1367.731 

CVT 3840 × 2160 @ 30 Hz  [RB1] 3840 2160 4000 2191 112 28 32 5 30 262,92 

CVT 3840 × 2160 @ 30 Hz  [RB2] 3840 2160 3920 2191 72 14 32 8 30 257,66 

CVT 3840 × 2160 @ 60 Hz  [RB1] 3840 2160 4000 2222 112 59 32 5 60 533,28 

CVT 3840 × 2160 @ 60 Hz  [RB2] 3840 2160 3920 2222 72 14 32 8 60 522,61 
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CVT 3840 × 2160 @ 60 Hz  [RB3] 3840 2160 4000 2222 152 14 32 8 60 533,47 

CTA 3840 × 2160 @ 60 Hz (VIC 97) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 93) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 94) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 95) 3840 2160 4400 2250 384 82 88 10 30 297,00 

CTA 3840 × 2160 @ 50 Hz (VIC 96) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 103) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 104) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 105) 3840 2160 4400 2250 384 82 88 10 30 297,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

 

 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 3840 × 2160 @ 50 Hz (VIC 106) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 60 Hz (VIC 107) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 114) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 116) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 100 Hz (VIC 117) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 100 Hz (VIC 119) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 120 Hz (VIC 120) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 4096 × 2160 @ 60 Hz  [RB2] 4096 2160 4176 2222 72 14 32 8 60 556,74 

CVT 4096 × 2160 @ 60 Hz  [RB1] 4096 2160 4256 2222 112 59 32 10 60 567,41 

CVT 4096 × 2160 @ 60 Hz  [RB3] 4096 2160 4256 2222 152 14 32 8 60 567,61 

CTA 4096 × 2160 @ 60 Hz (VIC 102) 4096 2160 4400 2250 216 82 88 10 60 594,00 

CTA 4096 × 2160 @ 120 Hz (VIC 219) 4096 2160 4400 2250 216 82 88 10 120 1188,00 

CTA 4096 × 2160 @ 100 Hz (VIC 218) 4096 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 4096 × 2160 @ 50 Hz (VIC 101) 4096 2160 5280 2250 216 82 88 10 50 594,00 

CTA 4096 × 2160 @ 48 Hz (VIC 115) 4096 2160 5500 2250 384 82 88 10 48 594,00 

CTA 4096 × 2160 @ 24 Hz (VIC 98) 4096 2160 5500 2250 384 82 88 10 24 297,00 

CTA 4096 × 2160 @ 25 Hz (VIC 99) 4096 2160 5280 2250 216 82 88 10 25 297,00 

CTA 4096 × 2160 @ 30 Hz (VIC 100) 4096 2160 4400 2250 216 82 88 10 30 297,00 

CVT 3840 × 2160 @ 120 Hz  [RB1] 3840 2160 4000 2287 112 124 32 5 120 1097,76 

CVT 3840 × 2160 @ 120 Hz  [RB2] 3840 2160 3920 2287 72 14 32 8 120 1075,80 

CTA 3840 × 2160 @ 120 Hz (VIC 118) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 5120 × 2160 @ 30 Hz  [RB1] 5120 2160 5280 2191 112 28 32 10 30 347,05 

CVT 5120 × 2160 @ 30 Hz  [RB2] 5120 2160 5200 2191 72 14 32 8 30 341,80 

CTA 5120 × 2160 @ 30 Hz (VIC 123) 5120 2160 6000 2200 216 32 88 10 30 396,00 

CVT 5120 × 2160 @ 60 Hz  [RB1] 5120 2160 5280 2222 112 59 32 10 60 703,93 

CVT 5120 × 2160 @ 60 Hz  [RB2] 5120 2160 5200 2222 72 14 32 6 60 693,26 

CTA 5120 × 2160 @ 60 Hz (VIC 126) 5120 2160 5500 2250 216 82 88 10 60 742,50 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 112 79 32 5 60 938,36 

5120 × 2880 @ 60 Hz 5120 2880 5200 2962 72 14 32 8 60 924,14 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 152 14 32 8 60 938,69 

CTA 5120 × 2160 @ 48 Hz (VIC 124) 5120 2160 6250 2475 384 307 88 10 48 742,50 

CTA 5120 × 2160 @ 50 Hz (VIC 125) 5120 2160 6600 2250 384 82 88 10 50 742,50 

CTA 5120 × 2160 @ 100 Hz (VIC 127) 5120 2160 6600 2250 384 82 88 10 100 1485,00 

CTA 5120 × 2160 @ 25 Hz (VIC 122) 5120 2160 7200 2200 384 32 88 10 25 396,00 

CTA 5120 × 2160 @ 24 Hz (VIC 121) 5120 2160 7500 2200 384 32 88 10 24 396,00 

CVT 7680 × 4320 @ 30 Hz  [RB2] 7680 4320 7760 4381 72 14 32 8 30 1019,90 
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CVT 7680 × 4320 @ 30 Hz  [RB1] 7680 4320 7840 4381 112 58 32 5 30 1030,41 

CVT 7680 × 4320 @ 60 Hz  [RB2] 7680 4320 7760 4443 72 14 32 8 60 2068,66 

CVT 7680 × 4320 @ 100 Hz  [RB2] 7680 4320 7760 4529 72 14 32 8 100 3514,50 

CVT 7680 × 4320 @ 60 Hz  [RB1] 7680 4320 7840 4443 112 120 32 5 60 2089,99 

CVT 7680 × 4320 @ 100 Hz  [RB1] 7680 4320 7840 4529 112 206 32 5 100 3550,74 

CTA 7680 × 4320 @ 120 Hz (VIC 201) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 120 Hz (VIC 209) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 30 Hz (VIC 204) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 30 Hz (VIC 196) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 60 Hz (VIC 207) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

CTA 7680 × 4320 @ 60Hz (VIC 199) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 7680 × 4320 @ 100 Hz (VIC 208) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 100 Hz (VIC 200) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 25 Hz (VIC 203) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 25 Hz (VIC 195) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 50 Hz (VIC 198) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 50 Hz (VIC 206) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 194) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 197) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 202) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 205) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

Unigraf 10240 x 4320 @ 30 Hz [RB1] 10240 4320 11000 4500 112 58 32 5 30 1485,00 

Unigraf 10240 x 4320 @ 30 Hz [RB2] 10240 4320 11000 4500 72 14 32 8 30 1485,00 

CTA 10240 x 4320 @ 24 Hz (VIC 210) 10240 4320 12500 4950 768 614 176 20 24 1485,00 

CTA 10240 x 4320 @ 25 Hz (VIC 211) 10240 4320 13500 4400 768 64 176 20 25 1485,00 

CTA 10240 x 4320 @ 30 Hz (VIC 212) 10240 4320 11000 4500 472 164 176 20 30 1485,00 

CTA 10240 x 4320 @ 48 Hz (VIC 213) 10240 4320 12500 4950 768 614 176 20 48 2970,00 

CTA 10240 x 4320 @ 50 Hz (VIC 214) 10240 4320 13500 4400 768 64 176 20 50 2970,00 

CTA 10240 x 4320 @ 60 Hz (VIC 215) 10240 4320 11000 4500 472 164 176 20 60 2970,00 

CTA 10240 x 4320 @ 100 Hz (VIC 216) 10240 4320 13200 4500 768 164 176 20 100 5940,00 

CTA 10240 x 4320 @ 120 Hz (VIC 217) 10240 4320 11000 4500 472 164 176 20 120 5940,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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APPENDIX D: PREDEFINED PATTERNS 

Fixed Patterns 

Selection Pattern Description 

Disabled 

 

The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Color 
 

Solid color. User selected RGB values 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White V-Strips 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels 

respectively. Default black / white = 20 / 20 pixels. Parameter range 

1 to 1000. 

RGB Wide Strips 

 

16 pixels high horizontal red, green, blue and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the 

given parameter (Color Step = cs) and selected color.  

(   p =   *     _  p h/256)  “ ”    g       5    (    u   1  )  

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. Color mode can be selected 

between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709) 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to left 

one pixel in each frame in a sequence. The length of the sequence 

is defined with parameter. Range 0 to 34 (default is 20) 

Square Window 

 

100% intensity white square horizontally and vertically centered. 

Height and width defined by parameter as the percentage of height 

and width of the frame (default 30). 
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Extended Patterns 

Selection Icon Description 

Select Image 
 

 u     i  g  up        y  h  u       i k           …       w    

Select DSC Image 
 

Custom DSC compressed image file uploaded by the user.  

  i k           …       w    

Unigraf PM5544 
 

Vpattern vector pattern based on PM5544 

Color Web 
 

Vpattern vector pattern. 

Chinese Town Full HD 
 

JPG Bitmap image (1920 x 1080 px) 

UG-2111 HLG Narrow 
 

Software generated pattern. HLG Narrow dynamic range. 

UG-2111 PQ Narrow 
 

Software generated pattern. PQ Narrow dynamic range. 

UG-2111 PQ Full 
 

Software generated pattern. PQ Full dynamic range. 

Multi 
 

Vpattern vector pattern. Multi-purpose pattern w square grid, cross-grids, 

1x1 cross-hatches, circles, and color bars 

SMPTE RP-133 
 

Vpattern vector pattern based on SMTPE RP-133 

SMPTE 303M 
 

Vpattern vector pattern. SMPTE 303M; Full Range; RGB values before 

gamma correction based on D65 and PAL primaries 

Blue 
 

Vpattern vector pattern. 100% Blue 

CirclesW 
 

Vpattern vector pattern. Concentric circles 

Complex 
 

Vpattern vector pattern. Complex Pattern w 64 steps 

Green 
 

Vpattern vector pattern. 100% Green 

Hor1W-Even 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in even rows 

Hor1W-Odd 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in odd rows 

Hor4W 
 

Vpattern vector pattern. Horizontal 4 px high White bars 

Hor10W 
 

Vpattern vector pattern. Horizontal 10 px high White bars 

Hor-10xB 
 

Vpattern vector pattern. 10 pcs horizontal Blue bars 

Hor-10G 
 

Vpattern vector pattern. 10 pcs horizontal Green bars 
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Extended Patterns (cont.) 

Selection Icon Description 

Hor-10xR 
 

Vpattern vector pattern. 10 pcs horizontal Red bars 

Hor-10xW 
 

Vpattern vector pattern. 10 pcs horizontal White bars 

HorRainbow-1024 
 

Vpattern vector pattern. Horizontal Rainbow Ramps 1024 steps 

HorRGBW-1024 
 

Vpattern vector pattern. Horizontal RGBW Ramps 1024 steps 

HorScale9 
 

Vpattern vector pattern. Nine Horizontal Color Ramps 

HorScaleW-64 
 

Vpattern vector pattern. Horizontal White ramp 64 steps 

HorScaleW-128 
 

Vpattern vector pattern. Horizontal White ramp 128 steps 

HorScaleW-X2 
 

Vpattern vector pattern. Horizontal White ramp w edges 128 steps 

InnerBox-BKtoB 
 

Vpattern vector pattern. InnerBox pattern from Black to Blue 

InnerBox-BKtoG 
 

Vpattern vector pattern. InnerBox pattern from Black to Green 

InnerBox-BKtoR 
 

Vpattern vector pattern. InnerBox pattern from Black to Red 

InnerBox-BKtoW 
 

Vpattern vector pattern. InnerBox pattern from Black to White 

InnerBoxMIX 
 

Vpattern vector pattern. InnerBox pattern mixed hues. 

InnerBox-RtoB 
 

Vpattern vector pattern. InnerBox pattern from Red to Blue 

Red 
 

Vpattern vector pattern. 100% Red 

Ver1W-Even 
 

Vpattern vector pattern. Vertical 1 px wide White bars in even columns 

Ver1W-Odd 
 

Vpattern vector pattern. Vertical 1 px wide White bars in odd columns 

Ver4W 
 

Vpattern vector pattern. Vertical 4 px wide White bars 

Ver10W 
 

Vpattern vector pattern. Vertical 10 px wide White bars 

Ver-10xG 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xR 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xB 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xW 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 
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Extended Patterns (cont.) 

Selection Icon Description 

VerBars75% 
 

Vpattern vector pattern. Vertical 75% intensity Color bars 

VerBars100% 
 

Vpattern vector pattern. Vertical 100% intensity Color bars 

VerRGBW-1024 
 

Vpattern vector pattern. Vertical RGBW Ramps 1024 steps 

X-HatchBK-C 
 

Vpattern vector pattern. Black 16 x12 Grid w Circle on White background 

X-HatchW 
 

Vpattern vector pattern. White 16 x12 Grid on Black background 

X-HatchW-C 
 

Vpattern vector pattern. White 16 x12 Grid w Circle on Black background 

X-HatchW-CC 
 

Vpattern vector pattern. White 16 x12 Grid w Ellipses, Circle and 100% 

color bars 

Gray Box 10 

 

Vpattern vector pattern. China 5.6 White Window 10% 

Gray Box 20 

 

Vpattern vector pattern. China 5.6 White Window 20% 

Gray Box 30 

 

Vpattern vector pattern. China 5.6 White Window 30% 

Gray Box 40 

 

Vpattern vector pattern. China 5.6 White Window 40% 

Gray Box 50 

 

Vpattern vector pattern. China 5.6 White Window 50% 

Gray Box 60 

 

Vpattern vector pattern. China 5.6 White Window 60% 

Gray Box 70 

 

Vpattern vector pattern. China 5.6 White Window 70% 

Gray Box 80 

 

Vpattern vector pattern. China 5.6 White Window 80% 

Gray Box 90 

 

Vpattern vector pattern. China 5.6 White Window 90% 

Gray Box 100 

 

Vpattern vector pattern. China 5.6 White Window 100% 

8 Level Gray 

 

Vpattern vector pattern. China 5.5 Ultimate 8 Level Grayscale 
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Extended Patterns (cont.) 

Selection Icon Description 

Black'n'White Window 

HDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR HDTV) 

Black'n'White Window 

SDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR SDTV) 

Black Line HDTV 

 

Vpattern vector pattern. China 5.10 Black Line HDTV 

Black Line SDTV 

 

Vpattern vector pattern. China 5.10 Black Line SDTV 

Black Window 

 

Vpattern vector pattern. China 5.7 Black Window 

Check Board 
 

Vpattern vector pattern. China 5.9 Check Board 

Line'n'Window 

 

Vpattern vector pattern. China 5.11 Line and Window 

Narrow White Window 

 

Vpattern vector pattern. China 5.19 Narrow White Window 

Single Dot 

 

Vpattern vector pattern. China Single Dot 

White Line HDTV 

 

Vpattern vector pattern. China 5.10 White Line for HDTV 

White Line SDTV 

 

Vpattern vector pattern. China 5.10 White Line for SDTV 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/ 

http://www.icdm-sid.org/
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APPENDIX E: SINK, SOURCE AND REPEATER TESTS 

Source DUT Testing 
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Audio Test 
Validate audio signal frequency and glitch-free audio 

reproduction 
●   

CEC Functional Test Set 

CEC functional test, CEC PHY Addr test,  

CEC Complete test, CEC Wake up test,  

CEC Standby test 
●   

CRC Video Tests 

CRC based single frame reference video test, 

CRC based single frame stability test, 

CRC based sequence of frames reference video test 

CRC based continuous sequence of frames 

reference video test  

●   

Pixel Level Video Tests 
Compare video frame sequence with a single 

reference 
●   

VRR Source DUT Tests (HDMI)  VRR static test, QMS Test, VRR Dynamic test ●   

HDR10+ Distribution Device 

Tests  

Tests from: 

HDR10+ TEST SPECIFICATION, HDR10+ Distribution 

Device 

  ● 

HDR10+ SSTM Tests for 

Source 

Tests from: 

HDR10+ TEST SPECIFICATION, Source Side Tone 

Mapping for Source Device 

  ● 

 

Sink DUT Testing  
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VRR Sink DUT Tests VRR static test, QMS Test, VRR Dynamic test ●   

HDR10+ CTS Tests  HDR10+ Display Device and SSTM Tests  ●  

Cable test  Cable Test Check ●   

Connection test Connection test ●   
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 R  Vi    T     –      Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

Configuration 

 

 

Test timeout: If enabled test will abort when the time has elapsed 

Repeat until timeout:   i  “T       g h” p         

Test length (# frames): Number of captured frames to test 

Errors allowed (# frames): Number of failing frames allowed before test Fails 

Repeat “Sequence Test” until timeout: 
Repeat test sequence until the timeout set (length 

parameter below omitted) 

“Sequence Test” length R p      u       h  “  qu     T   ” 

Expected Video Format Format of the signal expected 

Expected Frame Rate: 
Verify stability of the video signal. Verification 

 i       i  Exp            R    i         “ ” 

Number of captured reference 

frames: 
Number of frames stored as reference 

Capture Reference Frames: Capture reference frames for the test 

Folder to save failed frames: PC folder where failed frames are stored. 

Max number of saved frames: Maximum number of failed frames stored to PC 

Format of saved frames: 
Select saved image format (Binary file, PPM image, 

BMP image) 

Align 12 

12bpc values are be shifted to MSB of a 16bits 

container. If not checked, 12 LSB are used to store 

colour component values. 

Presets: Store and recall settings 
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CRC Based Single Reference Frame Video Test 

The test compares captured frames to a captured reference. In Configure dialog, please select 1 to 

CRC Capture length and click Capture Now. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to provided 

parameters and after that captures frames and compares the CRC (check sum) of their three color 

components to the provided reference until the number of bad frame limit provided is detected or the 

provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Total number of frames (default 2 00 ms) 

• Number of bad frames allowed (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Reference CRCs (R, G, B) 

CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE captures 

frames and compares their CRC (check sum) to the reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 100 00 ms) 

• Total number of frames (default 200 ms) 

• Number of bad frames allowed (default 20) 
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CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to provided 

parameters. After that captures frames to find a frame with matching CRC (check sum) of their three 

color components to the first provided reference. After the first matching CRC is found it compares 

the CRC of the following frames until the Number of frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 

CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color format) 

to provided parameters. After that captures frames to find a frame with matching CRC (check sum) 

of their three color components to the first provided reference. After the first matching CRC is found 

it compares the CRC of the following frames until the Number of frames tested parameter is reached. 

After that it resets the list and starts from the first CRC. The list is repeated until timeout or until the 

provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Expected color format 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 
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VRR   u      T T     –      Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

Configure 

VRR Max value: Maximum VRR frame rate 

VRR Min value: Minimum VRR frame rate 

VRR Static value: Static VRR frame rate 

VRR Step value: Change of current VRR value during a test 

VRR Time step value: Change of current VRR value during a test 

VRR Enable and M_Const: Click to open dialog for enabling VRR Enable and 

M_CONST 

VFront value: Click to open dialog for enabling Base VFront and RB 

Base Refresh Rate: Set Base Refresh Rate 

VRR Static Test 

Test verifies that DUT Source applies expected static VRR value. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts VRR 

mode. When VRR mode is detected, test verifies that received timing matches the VRR Value 

parameter and the data in received EMP packets match the timing. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For example, 

change VRR from 30 to 60 Hz with step for each 1 second. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts VRR 

mode. When VRR mode is detected, test verifies that VRR is changed after each time interval set by 

VRR Time parameter, and the applied VRR change is as set in the parameter. Test also verifies that 

data in received EMP packets match with applied VRR. 

VRR Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, change 

VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts VRR 

mode. When VRR mode is detected, test verifies that VRR is changed between each frame. Test also 

verifies that data in received EMP packets match with applied VRR. 
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Electrical Test Set – HDMI Rx  
Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-301 

Electrical Tests verify the continuity of the interface signals and the voltage levels applied by the 

driving electronics. 

Power Test 

Power Test verifies the voltage level on the +5 V power line (Pin 18) of the DUT source. The accepted 

value in HDMI specification is 4.7 V to 5.3 V on the sink side connector. ( alled “TP ” in the H MI 

specification). 

The test will measure the power line voltage using two loads: 0 mA and 55 mA. The latter is the test 

setup in HDMI CTS specification (HDMI CTS 1.4b: Test ID 7-11: +5V Power). The test will fail if voltage 

level on the power line is below or above the voltage range set by the parameters. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Power line low voltage limit (default 4 700 mV) 

• Power line high voltage limit (default 5 300 mV) 

TMDS Test 

TMDS Test verifies average voltage levels on TMDS signal lines (8 lines: CLK+/-, D0+/- D1+/- and 

D2+/-). The positive and negative lines of the TMDS differential pair are measured separately. 

TMDS uses DC balanced signaling. Sink pulls the lines up to 3.3 V (AVcc) and source applies the 

TMDS signal by pulling the line down to ground. On an active TMDS line average voltage level is half 

of the voltage swing below AVcc (AVcc – Vswing/2). By default, 2.6 V to 3.1 V.  

TMDS line voltages outside of the above range might indicate an abnormal situation like short circuit 

of two TMDS lines, short to ground, open circuit or a broken output driver.  

If the measured values fall outside the criteria set by the parameters, test result is FAIL. 

Note: Fail criteria for each test set-up should be considered separately depending on the source DUT and 

test cable configuration. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Main link low voltage limit (default 2 600 mV) 

• Main link high voltage limit (default 3 100 mV) 
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Au i  T        –      Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

Validate audio signal frequency and glitch-free audio reproduction 

Perform frequency check on the digital audio content and verify the content to be glitch-free. This 

test assumes that a pure sine-wave audio signal content is being transmitted to the test equipment. 

The test will first capture minimum of one second of audio content. The audio is then analyzed in two 

stages.  

First, the power spectrum is calculated, and the highest peak must be within the defined window. 

Resolution of the peak frequency check is better than ±1 Hz.  

In the second stage, received audio is checked for random glitches, such as dropped or duplicated 

samples. This is achieved by examining how the R V (“Relative  istortion Value”) changes over time 

within the sampled audio. 

The test is considered passed if power of audio content spectrum has its maximum within the defined 

window, and the number of detected audio glitches does not exceed programmed limit. 

 

Parameters in use 

• Expected sampling rate of audio signal (default 44 100 s/sec) 

• Expected audible (sine) frequency in Hz (default 1000 Hz) 

• Allowed deviation from expected frequency in Hz (default 1 Hz) 

• Number of audio glitches allowed per test (default 0) 

 

Click Location where the captured audio is to be saved to browse for the folder to store tests.  
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 E   u   i     T         –      Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

 

Parameters in use 

• Test timeout, in milliseconds 

• Local CEC physical address 

 

 

CEC Functional Test 

Test is intended to check that DUT does CEC initialization correctly after HPD. TE initialize EDID with 

configured address. Apply HPD and expected that Logical Physical addresses that presented in EDID 

will be applied with Report Physical Address message to inform TE about the mapping Logical and 

Physical addresses. That is expectation of CEC behavior. 

CEC Phy Address test. 
Test is intended to check that CEC line is working properly, and DUT can receive CEC Report Physical 

Address or customized OP Code. TE checks that HPD is high and CEC line available and send Report 

Physical Address (or customized OP Code) message in broadcast mode (or with specific destination). 

CEC Wake Up test 

Test is intended to check that CEC line is working properly, and DUT can send CEC Wake Up 

command. TE checks that HPD is high and CEC line available and wait for Wake Up message. 

CEC Stand By test 

Test is intended to check that CEC line is working properly, and DUT can send CEC Stand By 

command. TE checks that HPD is high and CEC line available and wait for Stand By message. 

CEC Complete test 

Test is intended to check that CEC line is working properly, and DUT can send sequence of 

commands from Stand By mode. TE checks that HPD is high and CEC line available. TE waiting for 

sequence of commands from DUT Wake UP and then again Stand By. 

 

Note: The default physical address in UCD EDID is 1:0:0:0. In order to simulate a change in the address, 

please use another address range 

 

Note: As a side effect, the CEC will also verify functionality of HPD and EDID reading if the test passes. 
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 ix   L v   Vi    T     –      Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

Compare video frame sequence with a single reference 

The test compares captured frames to the provided reference image at the pixel level by buffering 

the indicated number of captured frames first in the local UCD device frame buffer and after that 

downloads them to the PC for evaluation. 

 

The test compares the captured frames to a provided reference image on pixel level.  

• The color component values of each pixel in the captured frame is compared to the 

corresponding pixels in the reference image. 

• If the difference is larger than the provided tolerance, the pixel is considered failed. 

• If the number of failed pixels in a frame is larger than the provided tolerance, the frame is 

considered failed. 

• If the number of failed frames in the test is larger than the provided tolerance, the test is 

considered failed. 

• Failed frames can be stored for evaluation. 
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Browse image: Load reference image from disk 

Image width: Width expected 

Image height: Height expected 

Image format: Image format expected 

Bits per component: Bits per component expected 

Data format align: Video data alignment expected 

Frames count: Number of frames buffered for testing 

Maximum number of failed frames 

allowed per test: 

Number of failed frames allowed totally 

Maximum number of failed frames 

allowed per test: 

Number of failed pixels allowed per buffered frame 

Tolerance between pixel values: The allowed difference between a color component of 

pixel in the captured frame to the reference bitmap. 

Folder to save failed images: PC directory where failed frames are stored. 

Maximum number of exported frames: Maximum number of failed frames stored to PC 

Export format: Format of exported image: Binary file, PPM image,  

BMP image 

Align to  MSB 

12bpc values are be shifted to MSB of a 16bits 

container. If not checked, 12 LSB are used to store 

colour component values. 

Presets: Store and recall settings 

 

Capturing Reference Image 

User can capture received video as reference:  

1. In Settings dialog click the enable live preview icon . 
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2. When the preview has been enabled click the Capture reference icon  to store a frame and use 

it as reference. Before accepting the frame, stability of the video is verified with a CRC stability check. 

Captured CRC can also be verified by the user. 
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VRR  i k   T T     –      Tx 

Role: Product: 

HDMI Reference Source (HDMI TX) UCD-422, UCD-412 

Configure 

 

VRR Max value: Maximum VRR frame rate 

VRR Min value: Minimum VRR frame rate 

VRR Static value: Static VRR frame rate 

VRR Step value: Change of current VRR value during a test 

VRR Time step value: Change of current VRR value during a test 

VRR Enable and M_Const: Click to open dialog for enabling VRR Enable and 

M_CONST 

VFront value: Click to open dialog for enabling Base VFront and RB 

Base Refresh Rate: Set Base Refresh Rate 

Static VRR Test 

Test verifies that DUT Sink correctly applies a static VRR value. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has applied 

VRR correctly and provides the information in the dialog of the test. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For example, 

change VRR from 30 to 60 Hz with step 1 each 1 second. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has applied 

VRR correctly and frame rate is changing as expected. Operator provides the information in the dialog 

of the test. 

Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, change 

VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has applied 

VRR correctly and frame rate is changing as expected. Operator provides the information in the dialog 

of the test. 



  Appendix E: Sink, Source and Repeater Tests 

UCD-4XX User Manual • UCD Console 3.9 156 

       i   T    –      Tx 

Configure 

 

 

 

Total test time, in seconds: Set total test time in seconds 

Period, in seconds: Set periods in seconds 

Stop testing when status fail: Set False / True 

Enable to check SCDC version: Set False / True 

Enable to check SCDC status flag: Set False / True 

Enabl to check SCDC error counters: Set False / True 

SCDC error counter fail threshold: Set threshold for error counter failure 

 

Role: Product: 

HDMI Reference Source (HDMI TX) UCD-422, UCD-412 
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      T    –      Tx 

Role: Product: 

HDMI Reference Source (HDMI TX) UCD-422 

 

Cable Check Test 

 

Test is intended to check that cable can be properly used with UCD-422. Cable should be connected 

in loopback mode. 

 

Test tries to pass Link training on different rates. If errors are presented on the lanes, then TE applies 

different FFE level to find configuration where is the best quality (minimum of errors). 

If Link training can be done without errors on all link rates then cable quilified as acceptable for usage 

with UCD-422. 

Configure 

 

 

 

Test timeout, in seconds: Timelimit for the test 

Cable test mode: High speed can include detection errors on the high 

speed lanes. Low speed - detect that i2c and ddc lanes 

are working properly. All modes checks both High 

speed and low speed. 

Minimum FRL rate: Determine minimum of range for detection of cable 

quility 

Maxmum FRL rate: Determine maximum of range for detection of cable 

quility 

Treshold of allowed errors per lane: Determine allowed number of errors 

Timeout for capturing errors, in 

seconds: 

Determine period for screening errors 

Low speed line select: Configure witch lines of Low speed will be checked. 
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APPENDIX F: VTP PATTERN LANGUAGE 

General 
The Vpattern definition language (in the following simply “VTP”) is a straightforward yet flexible way 

of describing test patterns for UCD Generators. This description is providing an introduction and 

examples of the most usable instructions and parameters.  

The VTP language uses text command syntax. Each row represents one drawing instruction. The 

coordinate system can be either absolute or scaled. In the absolute mode the actual pixel position is 

referred while in the scaled mode the coordinates refer to the “ rawing resolution” used while 

drawing. For both absolute and scaling coordinates the origin is the upper left hand corner of the 

screen. 

Terminology 

The following terms are used in this document: 

Coordinate system: two numerical ranges of integer, positive numbers. E.g. {0,799},{0,599} or 

{0,10000},{0,10000}. 

Coordinates: a tuple of integer, positive numbers used to address a position on an image, e.g. 

(100,250). The first number is the horizontal position, the second one the vertical position. The actual 

position is always related to the coordinate system currently in use. 

Drawing resolution: the width and height of the space that can be used for drawing, expressed in 

pixels. E.g., 2560 by 1600. 

Drawing area: a 2-dimensional area spanning all of the drawing resolution, expressed in the current 

coordinate system notation. E.g., if the drawing resolution is 800 x 600 pixels, the drawing area 

includes all points (x,y) where x = 0 to 799 and y = 0 to 599 in ABSOLUTE mode or x = 0 to 10000 

and y = 0 to 10000 in SCALED mode. 

Notation 

The following notation is used in this document: 

• A token is enclosed by characters ‘<’ and ‘>’. For instance, <variable> represents a generic 

variable. 

•  ifferent legal choices for a command parameter are separated by character ‘|’. For instance, 

<variable> | <number> means that either variable or number can be used as parameters. 

• Items that can be repeated 0, 1 or more times are preceded by ‘{‘ and followed by ‘}*’. For 

instance {<number>}* means zero, one or more occurrences of a number.  

Syntax rules 

The following general syntax rules apply to VTP language files: 

• The VTP is a text-based, interpreted language. 

• Commands, variables, and constant names are not case-sensitive. 

• All text to the right of a semicolon (‘;’) is treated as a comment. 

• All strings are delimited by quotation marks (“a string”).  

• Quotation mark and backslash characters must be prefixed by a backslash character 

(a quotation mark character = \”) (a backslash character = \\). 

• Filenames cannot contain pathnames. 
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Commands 

Scaling commands 

All drawing commands using coordinates can refer either to absolute or scaled coordinates. The 

absolute coordinate system starts at 0 and its measurement unit is the pixel (vertically the line). It 

extends up to the maximum drawing resolution in use minus one, expressed in pixels too. 

Conversely, the scaled coordinate system ranges from 0 to 10000, independently from the drawing 

resolution. Its measurement unit is thus a flexible, virtual pixel. 

Absolute coordinates provide the fastest drawing speed, but they are resolution specific. Scaled 

coordinates are resolution independent while introducing a slight speed penalization. 

For both systems, the origin (0,0) refers to the upper left hand corner of the screen. 

ABSOLUTE 

Syntax: ABSOLUTE 

This command is normally used in the beginning of the VTP file. All drawing commands issued after 

ABSOLUTE will have absolute coordinate values, i.e., their coordinates will be interpreted as pixels 

and lines.  

The allowed coordinate values are from 0 to the maximum drawing resolution minus one. For 

instance, for a drawing resolution of 2560 x 1600 pixels, the allowed coordinate range (x,y) for x is 0 

to 2559 and for y 0 to 1599. 

Constants MAXX and MAXY can be used in place of the numeric values to achieve basic scaling 

capabilities.  

SCALED 

Syntax: SCALED 

All drawing commands issued after the SCALED command will have their coordinates interpreted as 

within a range from 0 to 10000 (10001 possible coordinate values), regardless of the current drawing 

resolution. Positioning can be calculated as percentages. If you wanted to address a point at 50% of 

the drawing resolution, then you would use the number 5000. If you wanted 75% you would simply 

use the 7500. 

  



  Appendix F: VTP Pattern Language 

UCD-4XX User Manual • UCD Console 3.9 160 

Graphics Drawing Commands 

All of the following graphics drawing commands use the currently selected foreground color for shape 

perimeter and filling. 

LINE 

Syntax: LINE x1 y1 x2 y2 

Draws a line from point (x1,y1) to point (x2,y2). 

Example: 

You can draw a white diagonal cross using either ABSOLUTE and SCALED coordinate mode and get 

the same result. 

ABSOLUTE ; Set scaling mode to absolute 

COLORDEPTH 8 ; 8 bits per color 

COLORRGB 255 255 255 ; white 

LINE 0 0 MAXX MAXY ; Draw a line from upper left to lower right corner 

LINE 0 MAXY MAXX 0 ; Draw a line from lower left to upper right corner  

Or if you want a fixed size for 640 x 480 resolution 

LINE 0 0 639 479 

LINE 0 479 639 0 

 

The pattern will look like this:  

Using SCALED instead of ABSOLUTE. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

LINE 0 0 10000 10000 

LINE 0 10000 10000 0 

BOX 

Syntax: BOX x1 y1 x2 y2 

Draws a filled rectangle with upper left corner (x1,y1) and lower right corner (x2,y2). 

Example: 

This code will create a full white screen with all resolutions. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

BOX 0 0 10000 10000 

  

(0,0) (MAXX,0) 

(MAXX,MAXY) (0,MAXY) 
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DOT 

Syntax: DOT x y 

Draws a single dot at location (x,y). 

FILL 

Syntax FILL x y 

Initiates a flood fill (or seed fill) with foreground color starting from position (x,y).  

CIRCLE 

Syntax: CIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Please, note that when using SCALED 

coordinates radius r is expressed using reference to vertical maximum. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

CIRCLE 5000 5000 2500 

The pattern will look like this:  

FCIRCLE 

Syntax: FCIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Filled with foreground color. Please, note that 

when using SCALED coordinates radius r is expressed using reference to vertical maximum. 

The pattern will look like this: 
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ELLIPSE 

Syntax: ELLIPSE x y hr vr 

Draws an ellipse with center point at (x,y), horizontal radius hr and vertical radius vr. 

You can use ELLIPSE instead of CIRCLE for example for compensating the stretching in applications 

where the displayed pixel is not square. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

ELLIPSE 5000 5000 3000 4000 

The pattern will look like this: 

Text Drawing Commands 

All of the following commands use the currently selected foreground color for the “foreground” pixels 

of the font and the currently selected background color for “background” pixels. 

TEXTPOS 

Syntax: TEXTPOS x y 

Sets the text drawing position to point (x,y).  

TEXT 

Syntax: TEXT <string> | <var> | <const> { <string> | <var> | <const> }* 

The command executes a CR and LF (carriage return and line feed) and then draws a text string 

<string>, a variable <var>, a constant <const> or a combination of them starting from the current text 

position.  

<string> parameter is a quoted sequence of characters. If the string contains a quote character (“) or 

a backslash character (\) then it must be preceded with a back slash character (\). 

<var> is a parameter variable (A – Z, MAXX, MAXY) defined by SET command. 

<const> one of the Timing Variables. Timing variables are defined by currently loaded timing 

parameters. Please refer to Chapter 3. 

 

Example: 

ABSOLUTE 

COLORDEPTH 8 

COLORRGB 255 255 255 

TEXTPOS 100 100  ; Text starting point 100 pixels from left edge and  

 ; 100 display lines down from top 

TEXT “HRES=” HR “ PIXELS” ; This will draw the text HRES then the value of variable HR  

; and PIXELS 

TEXT “Quote character \” and backslash \\” 
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Program Flow Commands 

REPEAT 

Syntax: REPEAT <variable> a b s 

All commands after between REPEAT and END command are repeated the number of times defined 

by <variable>. <variable> is set to value a before starting the first iteration loop. At the end of each 

iteration, variable is incremented by s (variable = variable + s). The REPEAT is terminated when 

variable reaches or exceeds value b, and the execution continues from the command following the 

END command. For example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

REPEAT W 0 10000 200 

LINE W 0 W 10000 

END 

A maximum of 2 REPEAT loops can be nested (placed inside each other). 

END 

Syntax: END 

This command follows a REPEAT command and defines a group of instructions to be repeated. 
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Color Commands 

The user can assign the used colors in two basic ways: either by giving the actual Red, Green and 

Blue (or R, G and B) color component values or using pre-defined color palettes. The first method is 

referred as True Color Mode and the latter as Palette Mode. 

In True Color Mode the numerical values given for R, G and B will be the actual output signal intensity 

values for the pixel in question. The numerical color value in Palette Mode will act as an address (or 

index) to a pre-defined color in a 256 color table. The output signal intensity will be the R, G and B 

value entry in the cell where the address points to. 

Palette mode can only be used with True Color Mode is . 

COLORDEPTH 

Syntax: COLORDEPTH n 

The command is used in True Color Mode (COLORMODE 2), to define the number of bits used for 

each color component (R, G and B) of the data to be displayed. Possible values for the parameter n 

are 6, 8, 10 and 12. If COLORDEPTH command is not used, 10 bits per color is used.  

Example: To display a bitmap that uses 8 bits for r, g and b (24-bit colors) you have to use 

COLORDEPTH 8.  

Command Nr of color bits Range of values for R, G and B 

COLORDEPTH 6 18 0 to 63 

COLORDEPTH 8 24 0 to 255 

COLORDEPTH 10 30 0 to 1023 

COLORDEPTH 12 36 0 to 4095 

 

COLORDEPTH can be used only once in a VTP file, and it has to be placed before all drawing 

instructions it is supposed to affect. 

COLORRGB 

Syntax: COLORRGB r g b 

The command defines the foreground color used for the following drawing commands. The command 

is used in True Color Mode only. 

The range of values for r, g and b depends on the bits per color used. If not changed with 

COLORDEPTH command, 10 bits per color is used. Please refer to COLORDEPTH command for 

range of values. 

Various Commands 

SET 

Syntax: SET <variable> n 

Assigns value n to programming variable called variable. n must be a positive number or zero. 
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Variables 

Timing Variables 

 

Timing Variable Value name 

HF  Drawing resolution horizontal size minus one 

HP  Drawing resolution vertical size minus one 

HR  Current timing horizontal frequency (MHz?) 

HA  Current timing horizontal period (pixels) 

HS  Current timing horizontal resolution (pixels) 

HBP  Current timing horizontal active time (pixels) 

HFP  Current timing horizontal sync length (pixels) 

VF  Current timing horizontal back porch length (pixels) 

VP  Current timing horizontal front porch length (pixels) 

VR  Current timing vertical frequency (MHz?) 

VA  Current timing vertical period (lines) 

VS  Current timing vertical resolution (lines) 

VBP  Current timing vertical active time (lines) 

VFP  Current timing vertical sync length (lines) 

PF  Current timing vertical back porch length (lines) 

HLB  Current timing vertical front porch length (lines) 

HRB  Pixel frequency (Mpps?) 

VTB Drawing resolution horizontal size minus one 

VBB  Drawing resolution vertical size minus one 

 

Expressions 

Any command numeric parameter can be replaced by an expression, according to the syntax below: 

<term> ::= <variable> | <constant> | <number> 

<expression> ::= <term> { ‘+’ | ‘-‘ | ‘*’ | ‘/’ | ‘%’ }  <term> 

<parameter> ::= <term> | <expression> 

Some example of legal parameter values: 

B 

MAXX 

342 

B + MAXX 

B / 2 

B * C 

Expressions have always positive integers or zero value. When an expression evaluates to a negative 

value, it is set automatically to zero. Number values are also always positive integers or zero. 
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Assignments 

A variable can be assigned a numerical value by using the SET command. 

The second parameter of the SET command can be replaced by an expression thus allowing 

commands like those here below: 

SET C B+MAXX 

SET K K+1 

SET K A+B 

Default state at VTP execution startup 

 

Coordinate system: ABSOLUTE 

Foreground color: 1023 1023 1023 

Background color: 0 0 0 

Image: Output image is cleared (all black) 

Variables: All variables are initialized to zero 

Color depth: COLORDEPTH 10 
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APPENDIX G: FIRMWARE UPDATE WITH QUARTUS 
The chapter below describes a procedure for updating UCD-4XX Series Firmware when the normal 

FW Update procedure fails. 

Note The firmware recovery procedure is only available for Windows operating system. 

Downloading Tools 
The Recovery patch is programmed to UCD Device with a separate tool called  

Intel® Quartus® Prime Lite Edition Design Software Version 18.1 for Windows. The tool can be 

downloaded from the Intel® FPGA website: 

https://www.intel.com/content/www/us/en/software-kit/665990/intel-quartus-prime-lite-edition-

design-software-version-18-1-for-windows.html 

1. On the download page, please select section “Individual Files”. Please download the software 

under “Intel® Quartus® Prime (includes Nios® II EDS)”. 

2. Please download and install the tool using defaults on the PC. 

 

 

Step 1 
1. Connect the UCD device to the power supply and switch on power.  

2. Connect the UCD device with a USB cable to the PC through USB connector (Please refer to 

chapter Product Description > Connections earlier in this document). 

3. Please locate the UCD-4xx_recovery.zip file. By default the file is at C:\Program 

Files\Unigraf\Unigraf UCD Tools\recovery. 

https://www.intel.com/content/www/us/en/software-kit/665990/intel-quartus-prime-lite-edition-design-software-version-18-1-for-windows.html
https://www.intel.com/content/www/us/en/software-kit/665990/intel-quartus-prime-lite-edition-design-software-version-18-1-for-windows.html
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4. Extract the content of the ZIP file in a folder on your PC (e.g., C:\Temp). 

5. Open Windows Command Prompt application. 

6. Navigate to the directory to where the ZIP file was extracted (e.g. cd \Temp). 

7. Connect a micro-USB cable to the JTAG connector on the UCD device (Please refer to chapter 

Product Description > Connections earlier in this document). 

8. In the directory where the ZIP file was extrected (e.g. c:\Temp) please edit file recovery.bat 

9. On line three, the parameter “Q ART S_ IR” is set to point to the folder where the Qartus 
Programmer was installed (by default C:\intelFPGA_lite\18.1). Edit and save as needed. 

10. In the  Command Prompt application make sure that the current directory is still the same (e.g. 

C:\temp). 

11. Launch batch recovery.bat by typing “recovery.bat” at the prompt. 

12. Please wait until the batch file has been completed (may take up to several minutes). 

Step 2 
Perform FW update procedure as described in section Installation > Firmware Update Procedure 

earlier in this manual. 

After Recovery procedure has completed, you can delete the files (in e.g., C:\Temp). 
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APPENDIX H: PLAYLISTS AND SCENARIOS 
      onsole’s Playback enables you to run scripts called playlists. Use playlists to stream video, 

audio and metadata. See the Unigraf UCD Console Playback Tutorial at 

www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-

tool/ 

Playlist 

A Playlist is a text script consisting of a [Device] block and [Scenario] block(s). A [Device] block lists 

the serial number of the device and connectortype (such as a displayport transmitter). [Scenarios] 

blocks have a caption (which are used to display sample content), a period (Scenario duration in 

milliseconds) and a relative path to a script text file (ex. Scenario_PSR1_Entry_N.txt). Scenarios are 

played in sequence. 

Scenario 

A scenario is a script text file to specify a sequence of video frames, metadata packets and audio to 

be transmitted. 

Frame Memory 

Before transmission content is loaded to frame memory buffer of the UCD device. Frame buffer 

memory limits content (number of frames) that can be played. UCD-5XX devices by default feature 

16 gigabytes of memory. This enables loading up to 320 4K or 80 8K video frames. Contact Unigraf 

for information for larger frame buffer sizes.  

Sample Content 

You can us sample content as a basis for creating custom test sequences: see UCD Console Playback 

tab. Sample content is stored by default (on Windows) at C:\Program Files\Unigraf\Unigraf UCD 

Tools\Resources\playback\content. See Sample Content in Playback in this Appendix. 

https://unigraf.sharepoint.com/sites/Products/Jaetut%20asiakirjat/General/User%20Manuals%203.5/www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-tool
https://unigraf.sharepoint.com/sites/Products/Jaetut%20asiakirjat/General/User%20Manuals%203.5/www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-tool
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   y i    

A playlist defines the UCD device to be used and the output destination for transmission. It lists 

scenarios the played (video and audio sequences including metadata) to be transmitted and their 

duration. 

Note: Playlists and Scenarios are technology dependent. Metadata (or packets) differ for HDMI and 

DisplayPort. 

Device block  

Section describes what device and what output connector to use. 

Key  Description  Possible values  

[Device] Required. Start of the Device block.  

serialnumber  Required. Specifies serial number of the UCD device.  

Th  ‘*’ wi              u    i     y           u    

device is connected to the PC.  

‘*’  

‘1722    ’  

connectortype  Required. Specifies output connector type to be used. 

Playlists shall not contain scenarios for different 

connector types.  

‘      u ’  

‘ i p  y      u ’  

‘      u ’  

reset  Only applies to UCD-323.  

Scenario block  

Section describes selected scenario and its playback parameters. Playlist runs scenarios in the order 

they are listed. 

Key  Description  Possible values  

[Scenario] Required. Start of a Scenario block. Playlists can have 

multiple Scenario blocks. 

 

caption  

 

Optional. Title. Any character string accepted. ‘      i  1’  

path  Required. Specifies relative path to scenario file.  Any valid path  

period  Required. Duration of Scenario in msec. The duration 

is ignored if close-after-up     i         ‘1’   

‘6    ’  

‘5   ’  

close-after-upload   p i      Wh          ‘1’,          i   v   i      

the Playback tool will exit after loading scenario 

content and starting playback.  

‘ ’    ‘1’  

    u   ‘ ’ 

execute-after-upload  

 

Optional. Executes provided command in cmd.exe or 

bash and waits for its completion. Calculation of 

‘p  i  ’               h          i   x  u     

‘   ip          i ’  

‘   i  

/h   /u   /    /’  

prompt Optional. Prompt text. Launches a dialog with prompt 

text and Ok and Abort buttons: 

‘R      vi    wi h 

camera and click 

OK or Abort’ 
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A Scenario is text file for specifying a specific sequence of video frames, events (packets) and audio 

to be played in order. Scenarios also set up the device state for transmission.  

Parameters 
Scenario parameters are defined below. items. 

Scenario item Description 

video Path and file name format of video frame files 

audio Path and file name of the audio file 

packets Path and file name format of metadata packet files 

porder Content Playing Order. Please see Content Playing Order below. 

mappin  

align1  Alignment of 12-bit binary pixel data. ‘1’ aligned to LSB; ‘ ’   ig            

audioswap ‘1’     Li     E  i    u i     p    

audiocompressed ‘1’ compressed audio; ‘0’ uncompressed audio 

audiosampling Audio sampling rate. E.g., 44100 

audiochannels Nr. of audio channels 

audiobits Audio bits per sample (usually 16 or 24) 

scrambler  ‘1’ scrambling enabled; ‘0’ scrambling disabled 

audiosync Audio sync  

colorspace Video color space: RGB; YUV444; YUV422; YUV420 

bitspercolor  Video color depth (bits per color) 

timing.hactive Timing: Horizontal active 

timing.vactive Timing: Vertical active 

timing.htotal Timing: Horizontal total 

timing.vtotal Timing: Vertical total 

timing.hstart Timing: Horizontal start 

timing.vstart Timing: Vertical start 

timing.hsync Timing: Horizontal sync width 

timing.vsync Timing: Vertical sync width 

timing.frate Timing: frame rate 

hdcp  HDCP version used (       1 4 2      ‘    ’) 

loadingRGB 
The R, G and B color components of solid color pattern shown when content is 

being uploaded to the device before playback (e.g., 0,0,0) 

linkRate 

Default link rate.  

HDMI: 0 = TMDS; 1 – 5 = FRL with 3, 6, 8, 10 and 12 Gbps link rate. 

DP: Link rate = Value × 0.27 Gbps. (E.g., 20 = 5.4 Gbps/lane (HBR2)). 

linkRateMin Minimum link rate desired. Scenario will fail if not achieved 

DSC timing 

parameters 

 

Parameters are different for DP and HDMI. See below. 
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DSC Timing parameters for HDMI 

dscFrameRate DSC Timing: Frame rate [fps] × 1000 

dscHcactive DSC Timing: Horizontal active 

dscHcblank DSC Timing: Horizontal blank 

dscVtotal DSC Timing: Vertical total 

dscVsync DSC Timing: Vertical sync 

dscVstart DSC Timing: Vertical start 

dscVactive DSC Timing: Vertical active 

 

DSC Timing parameters for DP 

dscFrameRate DSC Timing: Frame rate [fps] × 1000 

dscVtotal DSC Timing: Vertical total 

dscVsync DSC Timing: Vertical sync 

dscVstart DSC Timing: Vertical start 

dscVactive DSC Timing: Vertical active 

dscHtotal DSC Timing: Horizontal total 

dscHsync DSC Timing: Horizontal sync 

dscHstart DSC Timing: Horizontal start 

dscHactive DSC Timing: Horizontal active 
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Content Playing Order 

Play order is a sequence of steps. Steps are delimited with semicolons (;).  

Each step has:  

Range (possibly numbered e.g. allm_000.jpg, allm_001.jpg, …) of video frame(s)  

How many times the frame(s) are played 

Packet(s) (possibly numbered e.g. allm_0.bin, allm_1.bin, …) indices to be sent during the video 

frame(s) transmission  

Color format 

Optional frame rate when VRR/Adaptive-Sync is enabled 

Format 

Each scenario step is of the form : 

pV:R:E:FvXX; 

Parameters  

Please see table below for description of used parameters. 

Сh    Description  Possible 

values  

Examples  

:  Separator between step parameters.  ‘:’  See below 

;  Step delimiter. ‘;’  See below  

p  Optional. Indicates assertion of a HPD pulse on  

HDMI RX connector of UCD device during current step.  

Preceding video frame index. Only for HDMI playback.  

‘p’  ‘p1:6 :1:256;’  

‘p -59:6 :1:256;’  

V  Required. Video frame indices (zero based). Parameters 

are applied to all frames in the step. Images (possibly 

numbered) are loaded from the video file path. 

‘1’ 

‘1,2,5’  

‘ -59’  

‘1:6 :16:256;’ 

 ‘1,2,5:6 :16:256;’ 

‘ -59:6 :16:256;’  

R  Required. Repetitions of current step.  

For example, ‘1’ wi h 6                        h   

current step will be played only for 1/60 of a second.  

‘  ’  

‘1’  

‘1:  :16:256;’  

‘1:1:16:256;’  

E  Optional. Metadata packet indices (zero based): A single 

packet or a comma separated list of packets. 

The index may be of the form 3l15 (  w        ‘ ’)    

At which vertical line do we want to put our packet in. 

3l15 means insert packet 3 at line 15. 

Packets are loaded from the packets path. 

‘ ’  

‘4,1,29’  

none  

3l15 

‘1:  : :256;’  

‘1:  :4,1,29:256;’  

‘1:  ::256;’ 

0:10000:3l15:256;  

F  Required. Color format and color depth.  

See Color Format below.  

‘256’  

‘51 ’  

‘1:  : :256;’ 

‘1:  : :51 ;’  

vXX  Optional. Control of frame rate when VRR/Adaptive-Sync 

is enabled. To enable VRR/Adaptive-Sync, the 

corresponding HDMI VSIF event must be included. The 

parameter is in the      ‘vXX’, wh    ‘XX’ is the frame 

rate. 

‘v6 ’  

‘v  ’  

‘1:  : :256v6 ;’  

‘1:  : :256v  ;’  
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Color Format  

Color format is a two-byte value presented in decimal. The lower byte provides an index to used color 

space and the higher byte an index to the color depth. Please find the indexes in the table below. 

Index Color Depth  

(bits/color) 

Color Space 

0 6 RGB 

1 8 YCbCr 4:4:4 

2 10 YCbCr 4:2:2 

3 12 YCbCr 4:2:0 

4 16 – 

 

The parameter value is encoded as follows:  

[Color Depth] × 256 + [Color Space],  

where [Color Depth] and [Color Space] are indexes obtained from the table above. 

For example, parameter for YCbCr 4:4:4, 10 bits is ( 2 × 256 + 1 ) = 513.  

Pre-calculated values for available color formats are shown below: 

 6 BPC 8 BPC 10 BPC 12 BPC 16 BPC 

RGB  0 256 512 768 1024 

YCbCr 4:4:4  N/A 257 513 769 1025 

YCbCr 4:2:2  N/A 258 514 770 1026 

YCbCr 4:2:0  N/A 259 515 771 1027 
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Example 
Please find below description of Playlist SDR-HDR-HLG – HDMI. 

Playlist file (Playlist SDR-HDR-HLG - HDMI.txt) 

Playlist item and example content Description 

[Device] Start of device section 

serialnumber=* Only one UCD device present. 

connectortype=HDMI Out HDMI output 

[Scenario] Start of Scenario 1 

caption = SDR       i   i    “  R” 

period = 10000 Duration 10 sec 

path = Scenario_SDR_HDMI.txt Scenario file: Scenario_SDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 2 

caption = HDR       i   i    “  R” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_HDMI.txt Scenario file: Scenario_HDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 3 

caption = HLG       i   i    “ L ” 

period = 10000 Duration 10 sec 

path = Scenario_HLG_HDMI.txt Scenario file: Scenario_HLG_HDMI.txt in current folder 

[Scenario] Start of Scenario 4 

caption = SDR – HDR       i   i    “  R –   R” 

period = 10000 Duration 10 sec 

path = Scenario_SDR-HDR_HDMI.txt Scenario file: Scenario_SDR-HDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 5 

caption = SDR – HLG       i   i    “  R –  L ” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_HDMI.txt Scenario file: Scenario_SDR-HLG_HDMI.txt in current folder 
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Scenario File (Scenario_SDR-HDR-HDMI.txt) 

Scenario item and example content Description 

video=goldenGate0.jpg Video files in current folder, file name format goldenGate0.jpg 

( …) 

audio=<Audio not selected> Audio not selected 

packets=HDMI\Infoframes_0000.bin Packet files in folder HDMI\, file name format 

          _      i  ( …) 

porder=0:180:2:256;1:180:2,0:256; 180 frames of image index 0, Packet index 2, RGB 8 bpc 

180 frames of image index 1, Packets index 2 and 0, RGB 8 bpc 

align12=1 Pixel data is aligned to LSB 

audioswap=0 - 

audiocompressed=0 - 

audiosampling=0 - 

audiochannels=0 - 

audiobits=0 - 

scrambler=0 scrambling disabled 

colorspace=RGB444 Video color space: RGB 4:4:4 

bitspercolor=8 Video color depth: 8 (bpc) 

timing.hactive=1920 Timing: Horizontal active 

timing.vactive=1080 Timing: Vertical active 

timing.htotal=2200 Timing: Horizontal total 

timing.vtotal=1125 Timing: Vertical total 

timing.hstart=192 Timing: Horizontal start 

timing.vstart=41 Timing: Vertical start 

timing.hsync=44 Timing: Horizontal sync width 

timing.vsync=5 Timing: Vertical sync width 

timing.frate=60000 Timing: Frame rate 60 fps 

hdcp=none HDCP not enabled 

loadingRGB=52,127,150 Solid color pattern shown when content is being uploaded to the 

device before playback is R=52, G=127, B=150. 
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   p           i     y   k T   

     onsole’s Playback tab features a set of examples for the user to create custom test content. 

This content is stored by default in C:\Program Files\Unigraf\Unigraf UCD Tools 

\data\playback\content. It is advisable to create copy of the installed files and edit the copies. 

Note: Playlists and Scenarios are interface technology dependent.  

The provided examples are different for HDMI and DisplayPort. 

Provided examples for each interface are shown below: 

HDMI 
The following playlists are available for HDMI interface. 

 Playlist Name Description Location 

Basic Video & 

Audio Example 

Example playlist for demonstrating the 

use of video and audio files. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Basic 

VRR Example 

Playlist for demonstrating Variable 

Refresh Rate (VRR) capability of a DUT 

monitor. 

Utilizes extensively frame sequencing 

capability in scenario, and the use of 

metadata packets. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\VRR 

QMS-VRR 

Example 

Playlist for demonstrating Quick Media 

Switching - Variable Refresh Rate 

(QMS-VRR) capability of a DUT 

monitor. Utilizes extensively frame 

sequencing capability in scenario, and 

the use of metadata packets. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\VRR 

ALLM  

Playlist for demonstrating Auto Low-

latency Mode (ALLM) capability of a 

DUT monitor. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\ALLM 

Audio-Video 

Latency 

These scenarios can be used to 

estimate audio-video synchronization 

using external tools like Sync-One2 or 

similar. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\AV Latency 

HDR & Metadata 

Example 

Example playlist that demonstrates the 

use of video files and metadata packets 

in testing a DUT monitor 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\HDR 

GoldenGate 

Grayscale 

The scenarios show smooth transition 

though shades of gray from black to 

white. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Grayscale 

HDR10+ SSTM & 

SBTM Example 

Playlist demonstrates using HDR10+ 

SSTM VSIF for Source-Side Tone 

Mapping, and HDMI Forum SBTM VSIF 

for Source-Based Tone Mapping. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\SBTM-

SSTM 

Dolby Vision 

DEMO – Playlist  

A set of static images transmitted with 

matching Dolby Vision metadata. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Dolby 

Vision 
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Playlist: Basic Video & Audio Example 
The playlist sequences video files and audio according to the description below. 

Video 

Frames used for Scenario 1 and Scenario 2 (Image1.jpg, Image 2.jpg) 

Frame used for Scenario 3 and Scenario 4 (Philips.svg) 

Description of Scenarios 

 Name Duration Repeated sequence 

1 
Flip-flop with LPCM 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: Rhythm.wav 

2 
Flip-flop with AC3 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: 

44100Hz_16bit_AC3_2channels_60sec_sine.iec61937.bin 

3 Flip-flop Silent 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 frames Image1.jpg, 60 frames Image2.jpg,  

No Audio. 

4 
Philips 1920x1080p + 

1kHz 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 

5 
Philips 3840x2160p + 

1kHz 
60 s 

CTA 3840 x 2160 @ 60Hz (VIC 97), RGB 8 BPC 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 
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Playlist: Audio-Video Latency 

Note: To measure video latency, ULT-01 test tool is needed. 

Description of Scenarios 

These scenarios can be used to estimate audio-video synchronization using external tools like Sync-

One2 or similar. Video latency measuring requires the Unigraf ULT-01 tool. 

The pattern with a white patch is shown for 15 frames, and then the black screen is shown for 45 

frames. The audio beep is transmitted during the first frame of a white patch pattern. 

 

Video 

Frames used for the scenario (frame1.vpattern frame0.vpattern) 

 

  

  

 Name Duration Repeated sequence 

1 vic16 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

15 frames frame1.vpattern, 45 frame0.vpattern,  

Audio: beep.wav 

2 vic97 60 s 

CTA 3840×2160 60 Hz (VIC 97), RGB 8 BPC,  

45 frames frame1.vpattern, 15 frame0.vpattern,  

Audio: beep.wav 
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Playlist: HDR & Metadata Example 
Example demonstrates the use of metadata packets. 

Video: 

The Scenarios use four versions of the same image: GoldenGate0.jpg, GoldenGate1.jpg, 

GoldenGate2.jpg and GoldenGate3.jpg. 

All four images use the same dynamic range in pixel data but contain a text label indicating pixel 

dynamic range applied in the metadata. If DUT behaves correctly, applying different metadata 

changes the appearance of the image on DUT screen.  

Scenarios for HDMI Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

SDR 10 sec 180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

HDR 10 sec 
180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

HLG 10 sec 
180 frames GoldenGate2.jpg, Packets: Infoframes_0001, 

Infoframes_0002 

HDR10+ 10 sec 
180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 

SDR – HDR 10 sec 

180 frames GoldenGate0.jpg, Packets: Infoframes_0002; 

180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

SDR – HLG 10 sec 

180 frames GoldenGate0.jpg, Packet: – ; 

180 frames GoldenGate2.jpg, Packets: Packets: Infoframes_0001, 

Infoframes_0002 

SDR – HDR10+ 10 sec 

180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 
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Playlist: Grayscale 

Description of Scenarios 

The scenarios show smooth transition though shades of gray from black to white.  

 Name Duration Repeated sequence 

1 GrayFHD_60 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 12 BPC,  

120 frames: gray0.vpattern - gray119.vpattern,  

Audio: No audio 

2 GrayUHD_119 60 s 

CTA 3840×2160 119,88 Hz, RGB 12 BPC,  

120 frames: gray0.vpattern - gray119.vpattern,   

Audio: No audio 

 

Video 

Below you can see three example frames from the video. 

Gray0.vpattern 

 

Gray60.vpattern 

 

Gray119.vpattern 
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Playlist: Dolby Vision DEMO 

Description of Scenarios 

A set of static images transmitted with matching Dolby Vision metadata. 

 

 Name Duration Repeated sequence 

1 playFiles_scenario 30 s 

1920×1080 60Hz, RGB 8 BPC,  

4 frames: Video_0000.bin – Video_0003.bin, 

Infoframes: Infoframe0000.bin – InfoFrame0033.bin  

Audio: No audio 

  



  Appendix H: Playlists and Scenarios 

UCD-4XX User Manual • UCD Console 3.9 185 

Playlist: VRR Example 
Playlist demonstrates controlling VRR (Variable Refresh Rate) in Scenarios when using HDMI output. 

Video 

The image used for the test contains a combination of color bars, gray scales, and rotating items. The 

test uses a sequence of images creating a full rotation in 60 frames. 

Scenario with Video Mode 1920.1080 60 Hz 

The scenario uses 1920×1080 59.94/60 Hz video timing (VIC 16). No audio. 

 Name Duration Repeated sequence 

1 
FHD VRR 48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC. 

Packets: infoframe_00, infoframe_01 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 

 

Scenario with Video Mode 3840.2160 60 Hz 

The scenario uses 3840×2160 59.94/60 video timing (VIC 97). No audio. 

 Name Duration Repeated sequence 

1 
UHD VRR48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC.  

Packets: infoframe_00, infoframe_02 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 

Scenario with Video Mode 3840.2160 60 Hz 

The scenario uses 3840×2160 59.94/60 video timing (VIC 97). No audio. 

 Name Duration Repeated sequence 

1 
UHD VRR48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC.  

Packets: infoframe_00, infoframe_02 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 
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Playlist: QMS-VRR Example 
Playlist demonstrates Quick Media Switching QMS by sending Video Timing Extended Metadata 

(VTEM) with TFR changing between 48/1.001 and 60. 

Video 

The same as in VRR Example above. 
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Playlist: ALLM 
Playlist for demonstrating Auto Low-latency Mode (ALLM) capability of a DUT monitor.  

Video: 

The Scenarios use a series of images: allm_on_off_000.jpg to allm_on_off_0011.jpg. Text panel on 

the images indicate if ALLM is enabled or not. The first scenario is presented with ALLM enabled and 

the second by switching ALLM on and off sequentially. 

Scenarios for HDMI Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

ALLM Static 60 sec 

10 frames allm_on_off_000.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_001.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_002.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_003.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_004.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_005.jpg, Packet: allm_0.bin 

ALLM Toggle 60 sec 

10 frames allm_on_off_000.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_001.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_002.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_003.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_004.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_005.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_006.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_007.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_008.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_009.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_0010.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_0011.jpg, Packet: allm_1.bin 
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Playlist: HDR10+ SSTM & SBTM Example 

Description of Scenarios 

Playlist demonstrates using HDR10+ SSTM VSIF for Source-Side Tone Mapping, and HDMI Forum 

SBTM VSIF for Source-Based Tone Mapping. 

  

 Name Duration Repeated sequence 

1 SDR 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel1.jpg, repeated 180 times 

Packets: Infoframes_0005.bin, 

Audio: No audio 

2 HDR10+ SSTM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times 

Packets: Infoframes_0000.bin, _0005.bin, _0006.bin 

Audio: No audio 

3 SBTM G-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times, Packets: 

Infoframes_0000.bin, _0005.bin, _0007.bin 

Audio: No audio 

4 SDR – SBTM G-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video:  

Step1: Channel1.jpg, repeated 150 times, Packets: 

Infoframes_0005.bin 

Step2: Channel0.jpg, repeated 180 times, Packets: 

0000.bin, _0005.bin, _0007.bin 

 

Audio: No audio 

5 SBTM D-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times 

Packets: Infoframes_0000.bin, _0005.bin, _0008.bin 

Audio: No audio 

6 SDR – SBTM D-RDM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: 

Step1: Channel1.jpg, repeated 150 times, Packets: 

Infoframes_0005.bin 

Step2: Channel0.jpg, repeated 150 times, Packets: 

0000.bin, _0005.bin, _0008.bin 

 

Audio: No audio 
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Video 

Channel0.jpg 

 

Channel1.jpg 
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